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ANOTACE

Cilem ptredkladané diplomové prace je ptijit s postupem, jakym zplisobem analyzovat
EEG data, aby z nich byly patrné emoce. Prace detailné popisuje headset Emotiv EPOC+,
jenz byl pouzit pro méfeni EEG dat, moznosti piedzpracovani dat v toolboxu EEGIab,
upravu dat do kone¢né vhodné podoby pro klasifikaci v aplikaci Matlab. Navrzeny
postup praci byl aplikovan pii kombinovaném eye-tracking a EEG experimentu. Pro
experiment byla pouzita sada obrazki z databaze IAPS (International Affective Picture
System). Tyto obrazky slouzily v experimentu jako referencni data, na kterych byla
trénovana schopnost uUspésné klasifikovat emoce. Do experimentu vstupovaly jesté
snimky, které obsahovaly mapy. U téchto snimkti bylo cilem zjistit, zda osoba, ktera je
pozoruje, pocituje néjaké emoce. Druhou ¢asti experimentu byl dotaznik SAM (The Self-
Assessment Manikin). Pfi tomto dotazniku tcastnici sebehodnotili, jak na né obrazky
pusobily, formou piktografického ptitazovani emoci k jednotlivym obrazkim. Vystupem
prace je detailni popis postupu a porovnani obou vystupt experimentu, tedy klasifikace
EEG dat a vysledky dotazniku SAM. Soucésti prace je i manudl podrobné& popisujici
veskeré tkony potifebné pii zpracovani EEG dat. Tento manual figuruje jako volna
ptiloha ptedkladané prace.

KLICOVA SLOVA
Emoce, EEG, IAPS, kartografie, Emotiv EPOC

Pocet stran prace: 52
Pocet ptiloh: 6 (z toho 2 volna a 1 elektronicka)



ANOTATION

Main aim of this theses is to come with workflow describing how to analyze EEG
data in a way that it is possible to gain information of emotions from them. In the thesis
there is very thorough description of EEG headset Emotiv EPOC+ which was used for
EEG data measurements. Also there is description of possibilities of preprocessing the
data in EEGIab toolbox, than adjustments of data into their final form which is suitable
for final step which is classification in Matlab software. Designed workflow was than
applied on combined eye-tracking and EEG experiment. For the experiment there was
used a set of pictures from IAPS database (International Affective Picture System). These
pictures featured in the experiment as referential data because on data from these pictures
was trained an ability to succesfully classify emotions from EEG data. Next to 1APS
pictures, there was also pictures containig maps in the experiment. On the pictures with
maps, the main goal was to find out if person who is looking at them is experiencing any
emotion. Second part of the experiment was the SAM questionary (The Self-Assessment
Manikin). In this questionary participants of the experiment self-evaluated how the
pictures had effected them. Output of the thesis is detailed description of the workflow
and comparision of both parts of the experiment and their results. Part of the thesis is also
a manual with description of every steps during the EEG data analyze. This manual is
attached as an appendix.
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Emotion, EEG, IAPS, cartography, Emotiv EPOC

Number of pages: 52
Number of appendixes: 6
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UvoD

Studium emoci zdstavalo dlouho doménou psychologickych obort. S rozvojem
technologii a zvySenim jejich dostupnosti se rozsifilo i portfolio védeckych obort, ve
kterém pojem ,,emoce* zacina rezonovat.

Spojeni emoci a kartografie zlistavalo dlouho mimo oblast vyzkumu. AZ v poslednich
deseti letech se zacinaji objevovat prvni studie, které pracuji s emocemi. V kartografii je
mozny dvoji pfistup k emocim. Prvni piistup — a Castéji vyuzivany — se snazi zmapovat
emoce. Vysledkem tohoto pfistupu jsou mapy, které zobrazuji, jaké emoce a pocity maji
lidé v urcitych castech mapované oblasti. Druhy pfistup se pak snazi fesit problematiku
toho, jaké emoce maji lidé, ktefi se divaji na mapu, ¢i s ni pracuji. A pravé tento druhy
pristup se stal tématem predkladané prace, ackoliv se jednd zejména o pristup designovy
a umélecky.

Jak jiz bylo feceno, technologie se stavaji dostupnéjsi. Katedra geoinformatiky
disponuje low-cost brain-computer interface ptistrojem, ktery dovede zaznamenavat EEG
vlny. Za pomoci tohoto pfistroje byl proveden experiment, pfi kterém byla EEG data
meéfena na Ucastnicich, kterym byly mj. promitany snimky s mapami. Prace si klade za cil
zjistit, zda takové snimky u pozorovateli vyvolavaji emoce a zda jsou tyto emoce
detekovatelné v jejich EEG vlnach. Ambici prace neni detailni popis emoci z hlediska
medicinského, neni vni popsdna fyziologie emoci. Stejné¢ tak neni ambici prace
matematicky zdivodnovat jednotlivé kroky pti analyze dat.

Jedna se o prvni vyuziti pfistroje EEG Emotiv EPOC+ na katedife geoinformatiky.
Doposud nebyl pfistroj vyuzivan a nebyla ustavena metodika préace s piistrojem vcetné
nasledné upravy a zpracovani EEG dat. Vystupem prace je tedy detailni postup praci pti
zpracovani dat, v€etné popisu ptistroje Emotiv EPOC+ a jeho udrzby.

Tato prace byla podpofena studentskym projektem IGA PrF 2017 024 Univerzity
Palackého v Olomouci.
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1 CILE PRACE

Cilem prace je vyuziti zafizeni EEG Emotiv EPOC+ propojeného s eye-trackerem
SMI RED 250 pfi kartografickém experimentu. Vysledkem experimentu Se V piipadé
predkladané diplomové prace rozumi zejména metodika pfipravy a realizace experimentu
vcetné pouzitého hardwaru a softwaru, pficemz neni kladen diiraz na samotné kvalitativni
¢i kvantitativni hodnoty vychazejici z experimentu. DalSimi cili prace jsou zhodnoceni
veérohodnosti dat, jez jsou produkovany zatizenim EEG Emotiv EPOC+ a nasledné
navrhnuti moZnosti analyzy téchto dat. Pro naplnéni hlavniho cile prace byly
rozpracovany dil¢i, postupné cile.

V prvni fadé¢ se jednd o nastudovani problematiky diplomové prace z divodu
korektniho uzivani terminologie a vSeobecného pochopeni tématu tykajiciho se EEG
(elektroencefalografie), E-T (eye trackingu) a konceptu emoci. Souéasti tohoto cile je
zejména ustanoveni metodiky pro méfeni a nasledné zpracovani EEG dat vcetné vybéru
softwarli vhodnych pro naplnéni cila préce.

Druhym dil¢im cilem se stala ptiprava a realizace eye-tracking a EEG experimentu
S vybranymi obrazky pochazejicimi z IAPS (International Affective Picture System)
databaze. Vystupem z tohoto experimentu byla verifikace zatizeni EEG Emotiv EPOC+
a také ovéetfeni navrhované metodiky pro ur€ovéani emoci z EEG.

ZavéreCnym cilem prace se pak stala pfiprava a realizace kartografického eye tracking
a EEG experimentu, pii kterém budou testované subjekty plnit jednoduché prostorové
ukoly.

Vysledky prace umozni pouzivani zafizeni EEG Emotiv EPOC+ pro dalsi potieby
katedry geoinformatiky. Prace navrhuje a ustanovuje zdkladni metodiku ziskdni
a zpracovani EEG dat pfi kombinovanych eye tracking experimentech.
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2 METODY A POSTUPY ZPRACOVANI

V této kapitole jsou popsany pouzité metody, data a programy, které vedly
k vytvofeni diplomové prace. Vse je sefazeno v logické ¢asové posloupnosti (obr 1).

Reserse odborné literatury

Primérni a nezbytnou ¢asti diplomové prace byla reSerSe odborné literatury, pfi které
doslo kprvotnimu sezndmeni sfeSenymi tématy. Pro téma tykajici se
elektroencefalografie byly pouzity zejména publikace od Syslové a kol. (2010), Morané
(1995) a Misurce a Chmelafe (1990). Provadéni eye tracking experimentii spole¢né
s EEG se vénuje cela fada zejména zahrani¢nich autord. Vycet ¢lanku s experimenty je
uveden v seznamu pouzité literatury. Vzhledem k faktu, ze zkoumana témata prace, jako
jsou emoce a EEG, zaZivaji v poslednich letech rozvoj, objevilo se v nedavné dobé&
n¢kolik vysokoskolskych kvalifikacnich praci, které se problematikou zabyvaji. Za
v§echny mohou byt jmenovany napf. prace Strakose (2016), Hudy (2014) nebo Schaaff
(2008). K resersni ¢asti prace bylo pfistupovano opakované vzhledem k $ifce studované
problematiky.

Navrh metodiky zpracovani EEG dat
Cast, ktera nasledovala po resersi odbornych zdroji, se zabyvala navrhem metodiky

zpracovani EEG dat. Navrhovand metodika kombinuje postupy z nékolika obdobnych
experimentll provadénych zejména v zahrani¢i. Strucné by se dal postup charakterizovat
nasledujici posloupnosti:

e nameéfeni dat,

e preprocessing dat,

e extrakce charakteristickych rysi dat,

e klasifikace dat.

Vybaveni pro kombinovany eye tracking a EEG experiment

Nejdilezitéjsi soucasti praktické stranky prace bylo provedeni kombinovaného eye
tracking a EEG experimentu. Pfed zalitkem pfipravy experimentu bylo nutné
nastudovani pouzivaného hardwaru a softwaru. Experiment se konal v eye-tracking
laboratofi na katedie geoinformatiky (KGI) v Olomouci. Ta je vybavena statickym eye
trackerem SMI RED 250 a zafizenim EEG Emotiv EPOC+. Jedna se o EEG headset od
spoleCnosti Emotiv, ktery je navrzen pro ,kontextudlni vyzkum a pokrocilé brain-
computer interface (BCI) aplikace* (Emotiv EPOC, 2017). Pomoci 14 senzort, kterymi
headset disponuje, byla sbirana data pro potteby diplomové prace.

Spolu s vyse jmenovanym hardwarem je dodavan i software, ktery je pottebny pro
samotnou piipravu experimentu a sbér dat. Pro pfipravu a pribéh experimentu byly nutné
nasledujici softwary:

e SMI Experiment Center™ Software,

e SMI BeGaze™ Eye Tracking Analysis Software,
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e FEmotiv TestBench™,
e EPOC Control Panel™.
Prvni dva jmenované softwary byly pouzity pro pfipravu a spusténi experimentu,
ziskani dat (jak E-T tak EEG) a export dat. Druhé dva softwary pak slouzily pro kontrolu
a kalibraci headsetu a pro vizualni kontrolu EEG dat béhem experimentu.

Prvni kombinovany eye tracking a EEG experiment

V prvnim experimentu ucastnici pouze sledovali obrazovku monitoru, na které se
postupné zobrazovaly obrazky z databaze IAPS. Tuto databazi bylo nutné ziskat od
majitele, jmenovité od The Center for the Study of Emotion and Attention (Centra pro
studium emoci a pozornosti) spadajici pod University of Florida. Mezi obrazky
z databaze IAPS byly v experimentu ucastnikim promitdny i rizné snimky map. Kromé
pohybu oc¢i byla ucastnikim zaznamenavana i EEG aktivita. Déle byla soucasti
experimentu metoda sebehodnoceni pociti z pozorovani obrazku, tzv. Self Assesment
Manikin (SAM). Podklady pro ni byly také ziskany od vlastnika — The Center for the
Study of Emotion and Attention.

Druhy kombinovany eye tracking a EEG experiment

Planovany druhy experiment se m¢l od prvniho liSit formou ptlisobeni ucastniki.
Zatimco u prvniho experimentu jde pouze o pozorovani obrazovky, na které se promitaji
stimuly, pfi druhém experimentu mé¢lo jit o plnéni jednoduchych prostorovych uloh nad
mapami. Opét mély byt ucastnikiim zaznamenavany pohyb o¢i a EEG aktivita. Vzhledem
k vysledkiim v kapitole 5.2 nebyl tento experiment proveden. Odavodnéni je v kapitole
5.3.

Zpracovani ziskanych dat

Nameéfend primarni (raw) EEG data bylo nutné zpracovat a analyzovat. Prvnim
krokem ve zpracovani dat je tzv. faze preprocessingu (pfedzpracovani), pii které
dochézelo k filtraci dat, odstranéni artefakti a k analyze nezavislych komponent (ICA).
Pro tuto ¢ast prace byl pouzit Microsoft Excel a Matlab toolbox s grafickym
uzivatelskym rozhranim:

e EEGLAB 13.6.5b.

Pfedzpracovand data byla poté déale zpracovavana =za ucelem extrakce
charakteristickych ryst. Ztohoto divodu byla na datech vypocitavana vykonova
spektralni hustota za pomoci rychlé Fourierovy transformace (FFT). K vypoctim
dochazelo v softwaru:

e MATLAB R2016b,
ktery slouzil 1 pro toolbox EEGLAB. Pii praci byla pouZivdna 30denni trialova verze
softwaru MATLAB, u které je moznost opakované instalace i pies skonceni platnosti
licence.

Klasifikace dat
Zaverecnou casti, ktera nasledovala po zpracovani dat, se stala klasifikace dat.
Vzhledem K reSersi se velmi vhodnym klasifikatorem stala metoda Support Vector
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Machines (SVM) (Liu a kol., 2010; Lahane a kol., 2015; Schaaff, 2008; Aguinaga a kol,
2015). Jedna se o metodu strojového uceni s ucitelem. Klasifikace probihala v aplikaci

Classification Learner, ktera je soucasti softwaru MATLAB.

‘ Rederie ‘

ﬁ Navrh metodiky —m8 ————————
h —_—

2. kombinovany E-T /' data viastni

¢ orby  /

a EEG experiment

1. kombinovany E-T
HEgsEL > 2 EEG experiment

A J

/ EEGdatae.2z /

EEGdata €. 1

h 4

A4
Predzpracovani dat

Pfedzpracovani dat

v h 4
Extrakce Extrakce
charakteristickych charakteristickych
rysi rysi

v h 4

Klasifikace dat

Klasifikace dat

‘ Wyhodnoceni,

okomentovani
-« |

}‘ vysledki, sepsani

manualu

Obr. 1: Vyvojovy diagram prib&hu praci, $ed€ znazornéné planované, ale neuskuteénéné kroky (zdroj: vlastni
zpracovani autora, 2017).
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3 SOUCASNY STAV RESENE PROBLEMATIKY

S rozvojem technologii se na trhu zacala Vv poslednich letech objevovat stale nova
zafizeni. Diive striktné jednooborové pfistroje se zacaly postupné implementovat
i v dalSich v&dnich oborech. Jednou skupinou téchto piistroji jsou i tzv. BCI (Brain
Computer Interface). Ramadan a Vasilakos (2016) definuji BCI jako komplexni systém
zahrnujici jak hardware, tak software, ktery umoziuje pomoci mozkovych vin ovladat
pocitac ¢i jiné komunikacéni zafizeni. Pivod BCI miize byt nalezen v 1ékatském prostiedi.
Schwartz (2004) definuje BCI jako zafizeni propojujici mozek s okolnim svétem pomoci
pocitace, ktery zpracovava neuralni signal za ucelem ovladani externiho zafizeni. Takové
zafizeni, slouzici jako neuralni protéza, mulze umoznit nepohyblivym lidem jak
komunikaci, tak pohyb. V posledni dob¢é se pravé vyzkum v oblasti BCI nabyva na
objemu. Vzhledem ktomu, ze EEG je dostupné jako low-cost zafizeni s moznosti
ptipojeni k pocitaci, roste tak jeho pouziti v mnoha védeckych oborech mimo I¢kaiské
kliniky (Mavros a kol., 2012). Za ptiklad mohou byt uvedeny ovladani dronu pomoci
BCI (Kosmyna a kol., 2015) ¢i vyzkum lidskych emoci. Pravé vyzkum lidskych emoci je
hlavni doménou této prace.

3.1 Elektroencefalografie

Prvni zpravy o tom, ze ziva tkan produkuje elektrické fenomeny, pochézeji z druhé
poloviny 18. Stoleti od L. Galvaniho a A. Volty. V poloviné 19. stoleti vyvinul Du Bois
Reymond nepolarizovatelnou elektrodu, s jejiz pomoci registroval aktivitu zabiho mozku
(Misurec a Chmelat, 1990). Elektroencefalografie je zakladni elektrofyziologickou
metodou pro vySetfeni mozkové aktivity. Jedna se o neinvazivni metodu, pfi které se
aktivita snima pomoci povrchovych elektrod. Principem elektroencefalografie je
zaznamenavani Casové zmény elektrického potencidlu, ktery vznikd aktivitou membran
na synapsich neuront. Graficky zaznam zmény mozkové aktivity se nazyva
elektroencefalogram (obr. 2). Pfistroj, ktery méti mozkovou aktivitu a zaznaménava ji, se

Obr. 2: Ptiklad elektroencefalogramu (zdroj: vlastni zpracovani autora, 2017).
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nazyva elektoencefalograf. Pouziti elektroencefalografie se nejcastéji  vyskytuje
V neurologii a psychiatrii a to zejména pii klinickych vySetfeni epilepsie ¢i poruch
centralni nervové soustavy.

EEG jako trvaly Sum mozku obsahuje Siroké frekvenéni spektrum. Frekvencni
rozmezi ma fuzzy horni i dolni hranici (Moréan, 1995). Zaznamenané signaly na
elektroencefalogramu jsou kombinaci n€kolika typti mozkovych vin, které se od sebe
vzajemn¢ lisi frekvenci a amplitudou. Jednotlivé viny se dominantné projevuji v rtiznych
¢astech mozku a za raznych podminek (napt. bd¢€lost, relaxace oci, motoricky klid).
Zékladni rozdéleni typt vin je uvedeno v tab. 1. Rada publikaci uvadi rozdilné hodnoty
frekvence u jednotlivych typu vin. V tab. 1 je uvedeno dé€leni dle Moran¢ (1995). Kromé
uvedenych typt vin se dale mizeme setkat s vinami kappa (x), lambda (), sigma (o)
nebo mi (p).

Tab. 1: Typy mozkovych vin (zdroj: Moran, 1995).

Typ vin Frekvence [Hz]

Delta (3) 0,54
Theta (0) 5-8
Alfa (o) 9-13
Beta (B) 13-30
Gamma (y) 31-50

Snimédni EEG probihd pomoci povrchovych elektrod, kter¢é mohou byt bud’
samostatng, skryté v elektrodové Cepici nebo jsou ve formé tzv. headsetu. Tento zplsob
se objevuje zejména u low-costovych EEG zatfizeni. Kazda elektroda ma své kddoveé
oznaceni, které urCuje pozici umisténi elektrody na lebce. Kod se sklada z pismena
a Cisla, pficemz pismeno urcuje pozici v pomyslné rovin¢ lebky mezi kofenem nosu
a kostnim hrbolkem na tyIni kosti a ¢islo ur€uje pozici v pomyslné roviné lebky mezi
dvéma body tésné¢ pied usnim boltcem na obou stranéch.

Vyznam pismen je nasledujici:
e A = aurikularni (u$ni),
e Fp = frontopolérni,
e F = frontalni (¢elni),
e (= centralni (stfedni),
e T =temporalni (spankovy),
e P =parietalni (temenni),
e O = okcipitalni (tylni).
Vyznam ¢isel je nasledujici:
e suda Cisla = pozice nad pravou hemisférou mozku,

¢ licha ¢isla = pozice nad levou hemisférou mozku,
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e pismeno ,,z* = oznaceni pro elektrody v centralni linii.

Umisténi elektrod se fidi mezinarodné uznavanym tzv. 10-20 systémem. Pro tento
systém plati, ze veskeré elektrody jsou v kazdé pomysiné linii rozlozeny takovym
zpusobem, ze mezi dvémi sousednimi elektrodami je vzdy 10 nebo 20 % délky obou
rovin lebky, pficemz soucet v kazdé linii dava 100 % (Misurec a Chmelat, 1990).

3.2Emoce

Emoce — bézné pouzivané slovo v kazdodennim Zzivoté. Emoce jsou studovany
v mnoha védnich oborech — biologii, psychologii, neurovéd¢, antropologii ¢i sociologii.
Kazdy védni obor na problematiku emoci nahlizi z jiného thlu. Kvilli tomu se vSak
nemohou shodnout na definici tohoto pojmu ¢i dokonce néjakou z definici preferovat
(Cabanac, 2002). Kleinginna a Kleinginna v roce 1981 dokonce sepsali 92 definici
emoce. Jiz Aristoteles se zabyval emocemi. Popsal je jako: ,pocity, které meni lidi,
ovliviwji jejich usudky, a také jsou Ccasto doprovazeny bolesti nebo rozkosi“
(Encyclopaedia Britannica, 2017). Zakladatel empirické psychologie, ameri¢an William
James pfiSel vroce 1884 steorii, kdy emoce je vysledkem fyziologickych zmén
Vv lidském téle, které¢ se udaly kvili vnéjsimu podnétu. Celou myslenku uvadi James ve
své praci na prikladu setkani ¢loveéka a medvéda: ,,Selsky rozum nam rika, ze pokud se
setkame s medvédem, dostaneme strach a uteceme. Ja zde naopak obhajuji domnénku, Ze
takové poradi stavii je chybné. Spravné poradi je nasledujici. Vidime medvéda, usoudime,
Ze nejlepsim reSenim je pred nim utéct a kvili uteku dostaneme strach* (James, 1884).
Schachter a Singer (1962) definuji emoce jako stav fyziologického vzruSeni a stav
védomi odpovidajici mife vzruSeni. S postupnym rostoucim pozndnim a vyvoji novych
védeckych oboru se zacaly objevovat i nové definice. Cabanac (2002) pfijima emoce,
stejné jako ostatni psychické prozitky, za vysledky nervové aktivity odehravajici se
v mozku. Soucasné definice se také 1isi, ale velmi Casto se v nich opakuji vyrazy jako
,pocit,” ,mentalni stav*“ apod. Encyklopedie Britannica (2017) definuje emoci jako
komplexni proZitek v€domi, fyzického vjemu a chovani, ktery odrazi osobni duilezitost
konkrétni véci, udalosti nebo situace. Oxford Dictionaries (2017) pak emoci definuje jako
silny pocit odvozeny od nalady osoby, vztahu s ostatnimi nebo jinymi okolnostmi. Skolni
slovnik soucasné cestiny (2012) pak o emoci hovofii jako o psychologickém procesu,
zahrnujicim subjektivni zaZitky, libosti a nelibosti, provazeném fyziologickymi a jinymi
zménami.

3.2.1 Vybrané metody klasifikace emoci

Radost, strach, hnév, pycha, divéra — to jsou pouze piiklady z celé fady riznych
emoci. Kazdd emoce ma unikatni charakteristické stranky — signal, fyziologii a udélost,
ktera emoci predchazela (Ekman, 1992). Diky tomu, Ze emoce maji tyto charakteristiky,
je mozno je klasifikovat, o coz se védci snazili od zac¢atkd moderni psychologie. Wilhelm
Wundt v roce 1896 klasifikoval emoce ve tfech bipolarnich dimenzich. Prvni dimenze
obsahovala hodnoty libost a nelibost, druhd obsahovala hodnoty nadSeni a klid a tfeti
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obsahovala hodnoty napéti a klid (Reisenzein, 1992). Tato teorie pak dala zaklady
I dal$im teoriim o klasifikaci emoci.

Kruhovy model Jamese Russella

Jednou z teorii klasifikace emoci je Kruhovy model Jamese Russella. Psychologové
Vv dobé¢ pfed nim uvazovali o emocich jako o diskrétnich jevech. Russell (1980) naopak
fika, ze emocCni stavy nejsou navzajem nezavislé, ale maji mezi sebou velmi systematické
vazby. Russell tedy navrhl model, ve kterém jsou emoce zobrazeny jako kruh ve
dvoudimenzionalnim bipolarnim prostoru (obr. 3).

AROUSAL
b aktivovany
tenze nadseni
stres B =
ZLOBA STESTI
nastvani spokojenost
neprijemny prijemny VALENCE
deprese rozvaznost
SMUTEK RELAXACE
klid

Unava

deaktivovany

Obr. 3: Kruhovy model Jamese Russella (zdroj: Candra a kol., 2015).*

Prostor je definovan dvémi veli¢inami. Horizontalni veli¢inou je valence, tedy mira
pfitazlivosti ¢i averze osoby vii€i néjaké véci €1 udalosti. Zjednodusené miize byt feceno,
zda na osobu néco plisobi pozitivné nebo negativné. Pojem valence je odvozen od slova
ambivalence, které znamend soucasné pusobeni zcela protichlidnych citovych postojit
osoby. Vertikalni veli¢inou v Kruhovém modelu Jamese Russella je mira vzruseni, mira
zaujeti, mira aktivity (angl. arousal). Z obr. 3 je patrné, Ze pokud jsou emoce déleny dle
vyse jmenovanych veli¢in, mohou byt seskupeny do obecnéjsSich skupin emoci. Pokud
ma 0soba vysokou miru valence a zaroven vysokou miru aktivity a zaujeti, mohou se jeji
emoce oznacit jako Stastné, pokud ma osoba nizkou miru valence a vysokou miru
aktivace a zaujeti mohou se jeji emoce oznacit za nastvané apod. Vzhledem K obtizné
prelozitelnosti vyrazi arousal a valence do ceStiny budou déle v praci pro jednotlivé
dimenze pouzivany pouze anglické vyrazy.

PAD Emotional State Model
Na praci Russella navazal Albert Mehrabian, ktery doplnil Kruhovy model Jamese

Russella o tieti dimenzi. Tento emoéni model nese nazev PAD Emotional State Model
(P = pleasure, A = arousal, D = dominance). Osa dominance v modelu uréuje pocity

! upraveno
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osoby z hlediska dominance a kontroly nebo submisivity v opa¢ném ptipad¢. Jako ptiklad
mohou poslouzit emoce hnév a strach. Ob¢ emoce jsou negativni a vysoce vzruSivé, ale
zatimco hnév je dominantni, strach je submisivni (Mehrabian, 1996).

Plutchikovo kolo emoci

Vroce 1980 prisSel americky psycholog Robert Plutchik s tfidimenzionalnim
kruhovym modelem, ktery popisuje vztahy mezi emocemi. Model mlze byt zobrazen
bud’ jako rovinny, nebo jako prostorovy (obr. 4).

Obr. 4: Plutchikovo kolo emoci (zdroj: Wikimedia Commons,
2017).2

Barevné sektory v Plutchikové kole emoci vyznacuji osm primarnich emoé¢nich sméra
tak, jak je Plutchik definoval. Sméry jsou srovnany zpisobem, ze lezi naproti sobé
a zaroven jsou znazornény vzajemn¢ doplitkovymi barvami. S postupujicim smérem od
sttedu kruhu klesa intenzita barev a s tim i intenzita emoci v daném emo¢nim sméru.
Emoce, které jsou v prazdnych prostorech, se oznacuji jako primarni dyady a vznikly
kombinaci dvou sousednich emoci nachazejicich se v druhém kruhu od stfedu (Plutchik,
2001). Napriklad emoce laska vznikla kombinaci emoci radost a divéra.

3.2.2 Emoce v kartografii

Studium emoci v oboru kartografie zistdvalo dlouho nedot¢enym. Teprve
Vv poslednich 10 letech se toto téma zacalo vice probirat. O tom, Ze téma map a emoci
nabyva na vyznamu, svéd¢i 1 workshop Mezinarodni kartografické asociace s ndzvem
Maps & Emotions, ktery se bude konat v navaznosti na 28. Mezinarodni kartografickou

% upraveno
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konferencii pofadanou v ¢ervenci 2017 ve Washingtonu. V kartografii se na problematiku
emoci d4 nahlizet ze dvou smérii, pficemz jeden smér je spiSe védecky, zatimco druhy
umélecky. Prvni smér se zabyva studiem lidskych emoci generovanych riznym
kartografickym designem. Druhy smér se snazi zachytit a kartograficky vyjadfit emoce
spojené s uritym prostiedim (ICA, 2016). Prvnim smérem se zabyvali napiiklad
Fabrikant a kol. (2012), kdy testovali jak rozdilny kartograficky styl ptsobi na Ctenare
mapy. Nicmén¢ stav vyzkumu, jak mapy emoc¢né plisobi na jejich Ctenafe, je stale pouze
V plenkach a studie na toto téma se objevuji velmi sporadicky. Vyjimku tvoii samostatné
studie, které zkoumaji vliv barev na ¢tenare.

Druhy smér, pfi kterém se ,,mapuji* emoce Vv prostoru, je mnohem castéjsi, at’ uz se
jednéd o ziskévani dat pomoci Bio Mappingu ¢i crowdsourcingové zdroje. Mezi jeden
Z nejznam&jsich projektt v Ceské republice, pfi kterém se ziskavaji emoéni data metodou
crowdsourcingu, patii Pocitové mapy (pocitovemapy.cz), za kterym stoji Mgr. Jifi Panek,
Ph.D. z katedry rozvojovych studii na Univerzité Palackého v Olomouci.

Mapovani emoci stale zistava zcela neprozkoumané, nebot’ se jedna o mapovani
neviditelného jevu. Smér, kterym se nyni toto téma ubird, je zjistovani a hledani zptisobu,
jak nejlépe vizualizovat emoce v mape. Nicméné mapovani emoci je soucasti konceptu
deep maping, ktery je zaloZen na ideji, Ze ¢lovék muze opravdu poznat misto, pouze
pokud vezme v potaz i vzpominky a emoce vztahujici se k tomu mistu (ICA, 2016).

3.3 Prace a studie zabyvajici se aplikacnim uzitim EEG

ResSerSované prace by mohly byt rozdéleny do dvou kategorii. Jednou z nich jsou
védecké studie zabyvajici se jednak rozeznavanim emoci z EEG, ale také aplikaénim
uzitim technologii BCI. Druhou kategorii jsou pak kvalifika¢ni prace, jejichz cil byl az na
nékteré drobné odliSnosti velmi podobny cili predkladané prace. Velka ¢ast védeckych
studii pochdzi zzemi mimo severoatlanticky prostor, konkrétné¢ se jedna o studie
z Mexika, Austrélie, Singapuru, Indie, Ciny nebo Malajsie. Oddéleni a instituty, které
studie publikuji, jsou ve vétSin€ piipadl technologického charakteru, napt. katedry
vypocetni techniky, technické univerzity, katedra mechatroniky, v mens$i mife pak
biomedicinské instituty ¢i ustavy neuropsychologie.

Tematicky i postupem nejvice podobna predkladané praci je studie od Lahane a Kkol.
(2015). Cilem studie je analyza emoci z EEG, pficemz pfi zpracovani pouzivaji FFT
apro Kklasifikaci klasifikatory typu SVM. Bohuzel autofi neuvadgji, jaky typ
elektroencefalografu pro svoji praci pouzili. Cilem Murugappan a kol. (2010) bylo také
pomoci EEG klasifikovat emoce. Postup praci v jejich studii je srovnatelny s postupem
praci v predkladané diplomové praci, nicméné rozdily se nachdzeji v provedeni nékterych
casti. Autofi pouzivali pro meétfeni 64senzorové EEG, nepouzili FFT ale vinkovou
transformaci signdlu a pro klasifikaci pouzili metody K-nejbliz§iho souseda
a diskrimina¢ni analyzu. Stejnym problémem se zabyvali Candra a kol. (2015), ktefi se
snazili klasifikovat EEG viny do ¢tyf emoci. Data ziskali z experimentu, pii kterém
ucastnici pozorovali nékolik minutovych hudebnich videi. Pro klasifikaci pouzili
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klasifikator typu SVM, pii¢emz dosahli uspéSnosti klasifikace kolem 70 %. Nicméné
oproti navrhovanému postupu v této praci pouzili pro extrakci charakteristickych rysu
signalu vinkovou transformaci. Otazkou také ziistava, pro¢ autofi studie pouzili pro
trénovani dat a naslednou klasifikaci pouze data od péti ti¢astniki, ackoliv se jich tohoto
experimentu zacastnilo celkem 32.

Rozdilny piistup k ziskani emoci z EEG dat provedl Bos (2006). Pro ziskdni hodnot
emoci pouzival pouze data z tii EEG senzort, kdy vypocitaval poméry vinovych pasem
aa B, ¢imz ziskaval hodnoty dimenzi arousal a valence. Pro klasifikaci autor pouzil
binarni linedrni Fischerovu diskrimina¢ni analyzu. Klasifikace dosahla uspésnosti pies
90 %, nicméné problematicky se jevi fakt, Ze experimentu se zcastnilo pouze pét
ucastnikil, na které plsobilo celkem pouze 39 stimull rtiznych typi, jak vizudlnich tak
poslechovych. Sreeshakthy a Preethi (2016) se také zabyvali ziskavanim emoci z EEG
dat, nicméné hlavni rozdil v postupu praci oproti této diplomové praci je v klasifikaci.
Autofti nepouzili klasifikator typu SVM, ale pouzili tfi rizné umélé neuronové sité. Prvni
Z nich byla zaloZené na algoritmu optimalizace hejnem ¢astic, druha byla probabilisticka
neuronova sit’ a teti zalozena na kukaccim algoritmu. Vysledky klasifikace u vSech tii
neuronovych siti dosahovaly hodnot pies 90 % a to i pfes fakt, Ze se experimentu
zhcastnilo 32 subjektt. Khosrowabadi a kol. (2010) pro klasifikaci emoci z EEG pouzili
osm elektroencefalografickych senzorti. Experimentu se zacastnilo 26 osob, pfi¢emz jim
byly promitany stimuly z databaze IAPS. Stejné tak ucastnici hodnotili stimuly pomoci
dotazniku SAM, totozné jako je to provedeno v této praci. Rozdily jsou pak pii extrakci
charakteristickych rysii signalu, kdy autofi pouzili koheren¢ni funkci, a pfi klasifikaci,
kdy byla pouzita samoorganizaéni mapa. Uspésnost klasifikace se pohybuje v hodnotach
pfes 84 %. Aguifiaga a Ramirez (2015) ve své studii navrhuji postup, jak ziskat emoce
z EEG dat. Autofi pfi experimentu pouZili elektroencefalograf s 36 senzory, nicméné
pouzili pouze data z vybranych senzorli na zakladé Brodmannovy analyzy, ktera ptifazuje
pouze nékteré oblasti mozku k emo¢nim projeviim. Celkem 32 tcastnikiim experimentu
byly promitany audiovizudlni stimuly z databaze DEAP® (A Dataset for Emotion
Analysis using Physiololgical Signals). Pro extrakci charakteristickych rysi signalu
pouzili autofi vinkovou transformaci a pro klasifikaci pouZzili SVM Kklasifikatory. Celkova
uspésnost klasifikace se pohybovala v hodnotach pres 80 %. Studie autord Hidalgo-
Muiioz a kol. (2013) se odlisuje od ostatnich svym pivodem, nebot pochazi z katedry
experimentalni psychologie. Cil autorii ovSem zlstava stejny — analyzovat EEG data
a klasifikovat je do emocnich kategorii. V experimentu, jehoZ se ucastnilo 26 Zen, byl
pouzit elektroencefalograf's 21 senzory a jako stimuly slouzily obrazky z databaze IAPS.
Jako charakteristicky rys signalu autofi pouZzivaji hodnotu global field power, coz je
smérodatna odchylka potenciali namétenych na EEG senzorech. Pro klasifikaci pouzili
klasifikator SVM-RFE, ktery klasifikuje data v iteracich, pficemz s kazdou iteraci je
z klasifikace odstranéna &ast dat. Uspésnost klasifikace se s piibyvajicimi iteracemi
ptiblizovala hodnoté¢ 100 %. Aydin a kol. (2016) ve své praci pristupuji k hodnoceni

® http://www.eecs.qmul.ac.uk/mmv/datasets/deap/

21



emoci z EEG odlisSnym zptisobem. Data nem¢ftili, pouze je prevzali z databaze DEAP a to
V rozsahu pouhych ¢tyt audiovizudlnich stimulti a ¢ty ucastnikt. U téchto dat pak pouze
hodnotili velikost amplitudy vykonového spektra signali ve vybranych vinovych
pasmech. Autofi prezentovali zavéry, které je ovSem nutno, s ohledem na malou
objemnost zkoumanych dat, brat s rezervou. Liu a kol. (2010) ve své praci predstavuji
proces, kterym docilili rozpoznavani emoci z EEG Vv realném cCase. Z experimentu, pii
kterém ucastnici poslouchali zvukové stimuly z databaze IADS (The International
Affective Digitized Sounds), autoii studie rozezndvali Sest emoci. Pro méfeni dat byl
pouzit piistroj Emotiv EPOC, ovSem zpracovana byla data pouze ze tfi senzort. Jako
charakteristicky rys signalu autofi vypo¢itali fraktalni dimenzi signalu pomoci Higuchiho
algoritmu. Vypocitand emoce pak byla pfevedena na monitor, kde se zobrazil avatar
vyjadiujici ptislusnou emoci. Bohuzel autofi neuvadéji uspésnost klasifikace emoci.

Na ¢eském uzemi se téma emoci a EEG ve vétSing piipadu fesi ve formée diplomovych
praci. Bakalaiskd prace Vand¢kové (2014) z Ustavu biomedicinského inZenyrstvi na
Vysokém uceni technickém v Brné¢ se zabyva emocemi a jejich vlivem na signal EEG. Za
pomoci piistroje Emotiv EPOC, obrazkovych sad z databazi GAPED* (Geneva Affective
PicturE Database) a IAPS a dotaznikit SAM byl proveden experiment, ktery obsahoval 30
stimuld a jehoZ se zucastnilo 10 osob. Pro zjisteni hodnot dimenzi arousal a valence
z EEG dat autorka pouzivala obdobného postupu jako Bos (2006). Strakos (2016), ktery
svoji magisterskou praci vypracovaval na stejném ustavu jako Vanéfkova (2014),
testoval pfi experimentu emocni reakci osob pfi reklamnich spotech. Pro méfeni dat
pouzival jak pfistroj Emotiv EPOC+ tak laboratorni EGI GES 400 MR, coz je EEG
Cepice s 256 senzory. Po analyze dat autor pteSel ke klasifikaci, kterou provadél jak
pomoci klasifikdtoru SVM, tak pomoci umélé neuronové sit€ a to pro data z riznych
poctl senzord. V prvnim kroku klasifikoval data do Ctyf kategorii, nicméné uspéSnost
klasifikace se pohybovala v rozmezi 20-30 %. Po redukci na dvé kategorie se tspésnost
klasifikace pohybovala pro rozdilné pfistroje a rozdilny pocet elektrod vstupujicich do
trénovani dat v hodnotach mezi 56 a 64 %. Magiserska prace Hudy (2014) z katedry
informatiky a vypocetni techniky Zapadoceské univerzity v Plzni se zabyvd méfenim
emoci z EEG podnicenych vizudlnimi stimuly. Pfi experimentu byly ucastnikiim
pormitany obrazky z databaze IAPS a také stimuly zobrazujici pivo. MysSlenka
magisterské prace se totiz zabyva meéfitelnosti pitelnosti piva. Naméfena data autor nijak
neklasifikuje, nybrz pouze zkouma pribéh vin v ¢ase a velikost jejich amplitud v riznych
lebecnich oblastech. Kromé& elektroencefalografu vyuzival autor také méfeni
elektrodermélni aktivity. Udaje ziskané ze zkoumani amplitud vin pak porovnéval
S dotaznikem SAM, na ktery ucastnici experimentu také odpovidali. Magisterska prace
autorky Schaaff (2008) z Universitdt Karlsruhe navrhuje feseni jak klasifikovat emoce ze
signaltt EEG do tii kategorii (pozitivni, neutralni a negativni). Experimentu se ztcastnilo
23 osob, kterym byly promitany stimuly z databaze IAPS. Méteni probihalo pomoci EEG
Cepice s 19 senzory, z které byla ale data ze tii senzorti vypusténa pro dalsi zpracovani.

* http://www.affective-sciences.org/en/
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Pro klasifikaci pouzila autorka klasifikator typu SVM a také skryty Markovoviv model,
pticemz uspésnost klasifikace dosahovala u SVM hodnoty 62 % a u skrytého Markovova
modelu 45 %.

Kromé¢ studia emoci slouzi pfistroje BCI i k dal§im, rekrea¢nim aktivitim. Kosmyna
a kol. (2015) pouzili 16senzorovy elektroencefalograf pro pilotovani dronu pomoci EEG
vin. Princip zpracovani vin je identicky s postupem praci navrzenym v diplomové praci.
Rozdil je v experimentu, pii kterém ucastnici opakované pomoci myslenek trénovali
pohyb dronu. Skupina UcCastnikii experimentu byla rozdélena do tii casti, dle délky
trénovani pohybtl dronu — jeden den, jeden tyden a jeden mésic. Uspé&nost pohybu dronu
se pak pohyboval od 60 % pii jednodennim trénovani po 87 % pii mesi¢nim trénovani.
Reuderink a kol. (2013) ve své praci zkoumaji hodnoty dimenzi arousal, valence
a dominance bé&hem hrani pocitacovych her. Hra byla naprogramovana takovym
zpusobem, aby ztéZovala hra¢i hrani, napt. nefunkénost ovladani, vypnuti monitoru apod.
Takto napldnovany experiment trval 30 minut, pficemz kazdé dv€é minuty byl ucastnik
experimentu pozadan o vyplnéni dotazniku SAM, aby byl zaznamenan jeho emocni stav.
Vyplnéné dotazniky poté autofi porovnavali s naméfenym EEG, pii¢emz potvrdili
korelaci mezi dimenzemi arousal a valence ve vinovych pasmech alfa, delta a theta.

S kombinaci EEG, eye-trackingu a dalSich biometrickych dat pracuje ve své
diplomové praci Gedminas (2010). Pfi experimentu, ktery mél za cil otestovat, jak jsou
vnimany geovizualizace zobrazujici hurikdny, bylo krom¢é¢ EEG ucastnikim
zaznamenavano i EKG (elektrokardiografie) a EMG (elektromyografie). Pii zaznamu
EMG autor sledoval vyskyt svalovych zaskubl asociovanych s nepfijemnymi stimuly.
Data z EEG slouzila pro podporu evaluace experimentu. Hodnoceni dat EEG vychézelo
Z premisy, ze pii pozitivni stimulaci je zvySend mozkova aktivita v levé hemisféfe. Slanzi
a kol. (2016) ve své studii vyuzili BCI pfistroje v kombinaci s eye-trackingem pro
predikci kliknuti mySi na webu uzivatelem. Na péti existujicich webovych strankach
autofi provedli experiment, pii kterém 21 osobam bylo zaznamenavano EEG a takeé
pohyb a poloha o¢i pomoci eye-trackeru. Autofi pouzili Higuchiho algoritmus pro
vypocet fraktalni dimenze signalu, pii¢emz potom v kombinaci s eye-tracking daty

vvvvvv

dosahujici hodnoty pies 70 %.

Jak jiz bylo feceno v kapitole 3.2.2 vyzkum emoci v oboru kartografie je stale z velké
casti neprobadané Uzemi. Védecké studie, pii kterych by bylo pouZito BCI zatizeni
v souvislosti s mapami, nejsou dohledatelné. Nejblize k pouziti EEG pti vyzkumu
kartografického tématu mél jiz zminény Gedminas (2010). V piipadé jeho prace ovSsem
EEG slouzilo jako podplrna metoda, vétsi diraz byl kladen na eye-tracking a EMG.
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4 VLASTNI RESENI

V nasledujicich podkapitolach bude detailné popséano tfeseni predkladané diplomové
prace. Nejdiive bude popsano zatizeni Emotiv EPOC+, nésledovat bude obecny popis
vsech krokt potfebnych k dosazeni vysledkt. V zévéru této kapitoly pak budou popsany
vysledky experimentti, na kterych byl postup praci ovétovan.

4.1 Emotiv EPOC+

Leitmotivem diplomové prace je evaluace emoci z naméfeného EEG. Pro méfeni
EEG katedra geoinformatiky disponuje zafizenim EPOC+, které bylo vytvofeno a je
prodavano spole¢nosti Emotiv Inc. sidlici v San Franciscu.

EPOC+ je bezdratovy l4kanalovy EEG neuroheadset slouzici zejména pro BCI
aplikace, ale jeho nadstavbou je i1 vestavéné méteni urovni vybranych emoci. Jednotlivé
kanaly reflektuji mezinarodni 10-20 systém. Konkrétn¢ se jedna o kanaly s pozicemi
AF3, AF4, F3, F4, F7, F8, FC5, FC6, T7, T8, P7, P8, O1 a O2 (obr. 5).

Obr. 5: Umisténi senzort ptistroje Emotiv EPOC+
na lebce (zdroj: Ekanayake, 2011).

Navic je zafizeni jeSté vybaveno dvéma tzv. referencnimi kanaly na pozicich P3 a P4.
Referenéni kandly jsou nutné u pfistroji EEG s referenénim zapojenim elektrod. Takoveé
zatizeni funguje na principu, Vvjakém jsou zaznamenavany rozdily elektrickych
potencialll mozku mezi aktivnimi kandly a pravé referencnimi kandly, které jsou
inaktivni. Tyto kanaly jsou nejastéji umistovany na uSni boltce €1 kofen nosu.
Nevyhodou takového zapojeni je riziko kontaminace téchto elektrod mozkovou aktivitou.
(Pokorny, 2017). Jevi se jako pravdépodobné, Ze takova kontaminace mohla piisobit i na
zatizeni EPOC+, nebot’ referencni elektrody maji umisténi pifimo na lebce, konkrétné
V oblasti temenni kosti. Jednd se ovSem pouze o domnénku, nebot’ software dodavany se
zafizenim EPOC+ nezobrazuje hodnoty naméteného EEG pro referenc¢ni elektrody, a ani
V primarnich (raw) datech se tyto hodnoty nevyskytuji. Na zafizeni se vyskytuji jeste
dalsi dvé elektrody, které by mély doléhat z kazdé strany na skalni kost (os petrosum).

24



Tyto elektrody jsou také referen¢ni, nicméné standardn¢ obsahuji gumové, nevodivé
polstarky a maji tedy pouze kosmetickou funkci. Pti urCitych typech méteni EEG je pak
a v takovém piipad¢ se gumové polstarky vymeéni za vodivé, plsténé polstairky z elektrod
na pozicich P3 a P4.

Zatizeni EPOC+ disponuje zdznamovou frekvenci az 256 Hz. Vzhledem k tomu, ze
zafizeni bylo pouzivano vyhradné¢ v kombinaci s eye-trackerem SMI RED 250, byla
zdznamova frekvence sjednocena na 250 Hz. Realna zaznamova frekvence se vSak
pohybovala mezi hodnotami 248 a 249 Hz.

K tomu, aby bylo mozné provadét méteni EEG, jsou nezbytné nékteré kroky. Jednim
Z nich je nabijeni zafizeni, které se provadi pomoci adaptéru s mini USB konektorem.
Vyrobce uvadi, ze zafizeni je schopno pfi plném nabiti béZet nepietrzit¢ po dobu
12 hodin, pficemz plné nabiti baterie trva pfiblizné 4 hodiny (Emotiv, 2014). Dal§im
krokem je zachazeni se senzory a jejich osetfeni. Hlavnimi ¢astmi téchto odnimatelnych
senzoru jsou polstarky a pozlacené elektrické kontakty. Senzory se pred kazdym méfenim
pripeviiuji k EEG headsetu. Dulezité je, aby byly polstarky naséklé solnym roztokem
(napf. roztok na kontaktni ¢ocky), z diivodu zlepSeni vodivosti a tim ziskani kvalitniho
signalu pii méteni EEG. Po skon¢eni méfeni EEG se senzory sejmou z headsetu a ulozi
se do uzaviratelného drzdku k tomu uréenému, pficemz se znovu hydratuji solnym
roztokem. Je mozné, ze se v priab&éhu Casu na pozlacenych kontaktech vytvori uslechtila
rez zelené barvy. V takovém piipad€ je vhodnéjsi tuto rez ponechat, pripadné ji vycistit
pomoci alkoholu. Nikdy by se k ¢iSténi nemély pouzivat ostré predméty, které by mohly
poskodit funkénost kontaktt.

Prenos dat z EEG headsetu do pocitace je feSen bezdratové pomoci Bluetooth® Smart
pfipojeni. Sparovani headsetu s pocitatem se provadi pomoci USB bezdratového
ptijimace, ktery je dodavany spole¢né s headsetem.

Pro samotné méteni EEG dat zatizenim Emotiv EPOC+ je nutné mit dva softwary,
které jsou se zafizenim dodavany na instalacnim DVD. Prvnim z nich je Epoc Control
Panel™, ktery slouZi pro nastaveni spojeni mezi headsetem a pocitacem. V programu
jsou ukazatele sily bezdratového signalu, stav baterie a zejména kvalita signilu na
jednotlivych senzorech. Epoc Control Panel™ také umoznuje vytvofit kazdému uzivateli
osobni uzivatelsky ucet. Krom¢ vySe uvedeného se v programu vyskytuji néstroje
Expressivi™ Suite, Affectivi™ Suite, Cognitive™ Suite a Mouse Emulator. Nastroj
Expressivi™™ Suite zaznamenava pomoci EEG pohyby lidské tvéte, jako je mrknuti oka,
zvednuti obo¢i ¢i usmév. Diky procesu EmoKey, ktery bézi na pozadi, je mozné tyto
pohyby automaticky ptevadét na libovolnou kombinaci textu, kterd je pohyblim tvare
nastavena. Nastroj Affectivi Suite méfi z EEG urovné prednastavenych emoci.
Konkrétné se jedna o frustraci (frustration), zaujeti (engagement), meditace (meditation)
a kratkodobé a dlouhodobé nadseni (excitement). Tyto emoce nelze ménit a nikde neni
popséano, jakym zplsobem ¢i jakymi algoritmy je hodnot u emoci dosazeno. Zaroven
vzbuzuje zamysleni fakt, ze vySe vypsané emoce pulsobi soucasné, ackoliv jejich
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charakter je protichlidny (napf. frustrace a nadSeni). Nastroj Cognitive™ Suite
vyhodnocuje uzivatelovu mozkovou aktivitu a rozezndva jeho mySlenkové utmysly
tykajici se pohybu realnych ¢i virtudlnich objektii. Jinymi slovy feceno, uzivatel se snazi
pomoci myslenek natrénovat pohnuti predmétem. Cognitive™ Suite analyzuje mozkové
viny uzivatele, personalizuje je a pfifadi je k trénovanému pohybu. Tento pohyb Ize pak
pievést, opét pomoci EmoKey, na libovolnou kombinaci klaves na klavesnici a 1ze ho
uplatnit v riznych aplikacich nebo pf#i hrani her. Nastroj Mouse Emulator za pomoci
gyroskopu, ktery je zabudovany v headsetu, umoznuje pomoci otaceni hlavy ovladat
kurzor mysi. Veskeré néstroje obsazené v programu Epoc Control Panel™ maji uplatnéni
v oblasti BCI, nicmén¢ pro dosazeni cild prace jejich pouziti nebylo nutné.

Druhym softwarem potiebnym pro méteni EEG dat je TestBench™. Ten lze pouzit
pii EEG experimentu, pficemZ umi EEG data nahrat, zobrazit a analyzovat. V piipadé
predkladané prace probihalo méfeni EEG dat v kombinaci s eye-tracking experimentem.
Vzhledem kK situaci, kdy softwarové vybaveni na katedie geoinformatiky, kde experiment
probihal, umoziuje simultanni nahravani eye-tracking i EEG dat v softwaru SMI
Experiment Center™, nebyl software TestBench™ komplexnéji vyuzivan.

4.2 Metodika prace s EEG daty

Navrhovana metodika popisuje ve ¢tyfech dil¢ich kapitolach, jak pracovat s EEG daty
s cilem ziskat z nich emoce. Postup praci byl strukturovan do logickych celkd, které ve
svém nazvu reflektuji hlavni ¢innost v daném celku. Ty maji pevn€ dané potadi, které
nelze zaménovat. Postup praci je znazornén na obr. 6.

Méreni dat

Predzpracovani dat

Extrakce charakteristickych rysu

Klasifikace dat

Obr. 6: Postup praci pfi zpracovani EEG dat (zdroj: vlastni zpracovani autora,
2017).
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4.2.1 Meéreni dat

Me¢feni dat probihalo pfi kombinovaném eye-tracking a EEG experimentu v eye-
tracking laboratofi na katedfe geoinformatiky. Na zacatku experimentu bylo nutné
ucastnikovi vysvétlit princip experimentu a jeho Ucast v ném. Nebot' se EEG data
povazuji za osobni a citlivd, je tfeba s nimi nakladat diskrétné v souladu s ptistupem
k ochrané osobnich udaji (Reynolds a Picard, 2004). Vzhledem k citlivosti problematiky,
byl kazdému ucastnikovi po vysvétleni experimentu dan k podpisu informovany souhlas
(Ptiloha 1). V ném ucastnik potvrdil, Ze rozumi své Casti puisobeni v experimentu, ze

Obr. 7: Instalace headsetu na hlavu t¢astnika (zdroj:
Emotiv Epoc, 2014).

s jeho daty bude nakladéno diskrétng, ¢i Ze experiment neni diagnosticky a nelze z néj
vycist Zzadné mozkové abnormality, 1 kdyz by mohly byt pfitomny.

Po podepsani informovaného souhlasu ucastnikem nésledovala instalace headsetu na
ucastnikovu hlavu. Pii tomto kroku bylo dilezit¢é dodrZovat doporuceni vyrobce
0 umisténi senzord (obr. 7). Klicové senzory, podle kterych se fidilo umisténi celého
headsetu, byly ty na pozicich AF3 a AF4 a druhotné referen¢ni elektrody (opatiené
gumovymi, ne plsténymi polstarky). Elektrody uréené pro pozice AF3 a AF4 by se mély
ucastnika. Druhotné referen¢ni elektrody by pak mély doléhat na skalni kosti Gi€astnika.
Dtlezitym faktorem je symetrické posazeni headsetu na lebce a pokud mozno kolmy
dotyk plsténych polstarki s lebkou, ¢imz je dosaZzeno maximalniho kontaktu mezi
senzory a plochou lebky.
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Po nasazeni je tieba aktivovat senzory, které jiz byly napustény solnym roztokem.
Aktivace se provadi lehkym stiskem referencnich elektrod (pozice P3 a P4) a jejich
piidrzenim po dobu 10 az 20 vtefin. Béhem té doby by se méla v softwaru Epoc Control
Panel™ zobrazit aktivita a kvalita signalu na jednotlivych senzorech. Uroveini kvality
signalu je znazornéna péti barvami (obr. 8) — ¢erna (zadny signal), ¢ervena (velmi slaby
signal), oranzova (slaby signal), zluta (dostateény signal), zelena (idealni signal) -

(@ EPOC Control Panel 1.0.0.0 L&

Application Tool EmoKey Help

ENGINE STATUS USER STATUS

IR System Status: Emotiv Engine is ready Headset User.
Y\ System up Time: 115,654 G +] [sashaz37 +] epoc control panel { 2,
& */  Wircless Signal Good eeee
_ Expressiv Suite I Affectiv sulte{ Cognitiv Suite [ Mouse o

StatusOK...

problem persists, this may indicate 2 problem with the Emoti headset. -

, Orange or Red: The sensor is not making good contact with your
scalp. Check that the felt pad Is making comfortable but firm contact with your
scalp. If the contact Is adequate, ensure that the felt pad Is moist. If the
sensor’s Indicator color becomes lighter, the signal quality Is improving. If the
sensor's indicator color Is getting darker, the signal quality is deteriorating. If
problems still persist, try parting the hair in the vicinity of the electrode so the
felt pad makes better contact with your scalp.

Repeat Step 6 for each of the remaining electrodes until all the sensors
have adequate contact quality. Although the majority of indicators should display
green, the Emotiv detections will usually tolerate input from up to several sensors
vihose indicators display yellow.

If at any time the reference sensors (located just above and behind ‘

your ears) no longer have a good ion (i.e. are not ] 3
green), immediately restore those sensors to green before proceeding =
further.

Obr. 8: Zobrazeni kvality signalu na senzorech v prostiedi Epoc Control Panel™ (zdroj:
http://developers-club.com/posts/115055/, 2011 ).

pfi¢emz kvalita signalu na senzoru by méla dosahovat nejhtife zluté barvy.

Ve vétSingé pripadit se pti prvnich pokusech nedafilo aktivovat pienos signdlu na
senzorech, nebot’ vlasy ucastnikt velmi rychle vysusovaly senzory. Headset tedy musel
byt ucastnikovi sejmut z hlavy, senzory znovu hydratovany a cely postup nasazeni
a aktivace opakovan. Ve vyjimecnych piipadech se ani po dikladné hydrataci nepodatilo
senzory aktivovat. ReSenim takové situace se stalo vypnuti a opétovné zapnuti headsetu
spolu s odpojenim a opétovném piipojeni USB bezdratového pfijimace. DalSim
problémem vyskytujicim se pti aktivaci elektrod, byla nefunkénost vybranych senzort.
V takovém piipadé¢ bylo nutné tyto vymenit za jiné.

V prabéhu instalace headsetu na ucastnikovu lebku je vhodné popisovat ukony, které
operator experimentu provadi, v€etné¢ varovani o mozném nepiijemném pocitu kvuli
mokrym senzorim. Pfed samotnym spusténim experimentu by mél byt ucastnik
upozornén na fakt, Ze zafizeni je velmi citlivé na jakékoliv zmény polohy hlavy
a sebemensi pohyby vnaseji do vyslednych dat nezddouci prvky, tzv. artefakty. Artefakty
je dle Moran¢ (1995) mozné délit na fyzikalni a biologické. Mezi fyzikalni jsou fazeny
elektromagnetickd indukce ¢i pfechod signalu mezi senzorem a kizi, mezi biologické
patii svalovy potencidl, EKG, dech ¢i pohyb oci a vicek.

Po uspésné instalaci headsetu, zajisténi kvalitniho signalu na elektrodach
a informovani tc¢astnika prob&hl samotny kombinovany eye-tracking a EEG experiment,
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pii kterém byla naméfena data o pohybu o¢i béhem experimentu a EEG data, na které je
Vv praci predevsim kladen duraz. Data z experimentu lze exportovat v nékolika formatech.
Nativnim souborem pro spankova a EEG data je soubor formatu .EDF (European Data
Format). Soubor takového formatu slouzi zejména pro ulozeni a sdileni multikanalovych
biologickych dat (Alvarez-Estevez, 2017). Dalsi z moznych exportnich formati dat je
klasicky .TXT format. Ten byl v praci upiednostnén z diivodu moznosti prohlédnuti
struktury souboru, coz soubor formatu .EDF bezplatné neumoziuje.

Vystupni soubor byl strukturovan do tabeldrni formy, pti¢emz obsahoval 52 sloupcii.
Obsahem souboru byly zakladni informace o ucastnikovi, nazev stimulu, informace
0 poloze o¢i ucastnika, hodnoty emoci, které zafizeni EPOC+ produkuje, hodnoty
pochazejici z gyroskopu a zejména hodnoty EEG z 14 senzort.

4.2.2 Pfedzpracovani dat

Naésledujicim krokem po naméteni dat bylo pfedzpracovani dat. Hlavnim smyslem
ptedzpracovani dat je jejich Gprava do takové podoby, aby na nich mohla byt provedena
naslednd analyza. Pro ptfedzpracovani dat byly pouzity softwary Microsoft Excel
a EEGlab. Excel byl pouzit zejména pro filtracni, organizacni a pfipravné prace, zatimco
EEGIab, coz je open source toolbox pro Matlab, slouzil, jak jiz ndzev napovida, pro
samotnou upravu EEG dat. Vyhodou toolboxu EEGlab je jeho dostatecné kvalitni
a prehledné GUI (Graphic User Interface). I pies fakt, Ze toolbox je Sifen jako open
source, tedy zdarma, je pro jeho spusSténi nutnd instalace softwaru Matlab, jehoz licence
je zpoplatnéna.

Pocatecnim krokem faze pitedzpracovani dat se stalo tfidéni a redukce dat.
Z ptivodniho textového souboru obsahujici veskeré informace bylo nutné vytvofit nové
textové soubory. Pro kazdého ucastnika a kazdy stimul, ktery byl ucastnikovi béhem
experimentu promitnut, byl vytvofen novy textovy soubor v tabelarni formé obsahujici
vyhradné numerickd data z jednotlivych senzorti. Pfitomnost jinych informaci vcetné
casové slozky ¢i nazvl sloupcii v textovém souboru byly neZadouci z divodu chyby
nacitani pfi nahravani souboru do toolboxu EEGIab.
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Grafické uzivatelské rozhrani toolboxu EEGlab je dostatecné prehledné a intuitivni.
Sestava se z hlavniho okna, ve kterém jsou zobrazené informace o nahranych EEG datech
(tzv. datasetu), a z listy zalozek, které obsahuji rizné piikazy a funkce (obr. 9). Mezi

4| EEGLAB v13.6.5b — O >
File Edit Tools Plot Study Datasets Help u
——#2: nazev_dataset

Filename: none

Channels per frame 14

Frames per epoch 870

Epochs 1

Events none

Sampling rate (Hz) 250

Epoch start (sec) 0.000

Epoch end (sec) 3.476

Reference unknown

Channel locations Ho

ICA weights No

Dataset size (Mb) 0.1

Obr. 9: GUI toolboxu EEGlab (zdroj: vlastni zpracovani autora, 2017).

informace zobrazené v hlavnim okné patii nazev datasetu, pocet senzorid, pocet epoch
a udalosti, po€et zaznamenanych hodnot, zdznamova frekvence a celkové trvani epochy.
Zalozka File obsahuje nastroje, tykajici se nahrani, ulozeni a exportu EEG dat. V zalozce
Edit se skryvaji nastroje zabyvajici se Upravami metadatovych informaci o datasetu,
vybéru pouze urCité casti nahranych dat ¢i prostorové lokalizaci senzord na lebce.
ZaloZzka Tools obsahuje jiz tematicky zaméfené nastroje pro tpravu EEG dat. Patii sem
nastroje jako filtrace dat, vizualni odstranéni dat, extrakce epoch, odstranéni kolisani
nulové izolinie, analyza nezavislych komponent (ICA) a dalsi. V zaloZce Plot pak jsou
k nalezeni nastroje pro vizualizaci dat.

Prvotnim krokem po spusténi toolboxu EEGlab je nahrani EEG dat v podobé
ptipraveného textového souboru. Nahrani textového souboru se nachazi v menu File >
Import Data > Using EEGLAB functions and plugins > From ASClII/float file or Matlab
array. Dilezitym udajem, ktery je potfeba pii nahrdvani dat zadat do pole tomu
ur¢enému, je hodnota zadznamové frekvence, kterd v ptipad¢ predkladané prace cini
250 Hz.

Odstranéni artefakt by mélo byt nedilnou soucasti predzpracovani (Aydin, 2016;
Candra a kol., 2015; Gorgen, 2010; Hidalgo-Muioz a kol., 2013; Murugappan a kol.,
2010). Pro odstranéni artefaktl lze pouzit vicero metod, avSak zddnd kombinace
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nepovede k absolutnimu odstranéni artefaktd (Bos, 2006). Pfilisné odstranéni artefaktti
naopak neni zadouci, nebot’ i data ovlivnéna artefaktem mohou nést uzitecnou informaci
(Murugappan a kol., 2010). Jako jedna z variant pro odstranéni artefaktii se jevi nastroj
Vizualni odstraneni dat (Tools > Reject continuous data by eye). Takova metoda, pfi
které se oznaci a smaze Casovy usek dat pouze na zdklad¢ vizudlniho vjemu, vyzaduje
hlubokou a né€kolikaletou znalost v oblasti elektroencefalografie. Dalsi nevyhodou tohoto
nastroje je jeho ¢asova naro¢nost, kdy by se musel u kazdého textového souboru prohlizet
elektroencefalogram.

Zptsobem, jak odstranit cast artefaktl, je pouziti nastroje Analyza nezavislych
komponent (Tools > Run ICA). V oblasti zpracovani signali mize velice Casto nastat
problém, kdy namétfené signaly jsou ovlivnény néjakym faktorem a neodpovidaji tedy
signdlim plvodnim. Jako tento faktor mlze vystupovat napt. nizka selektivita senzoru,
kterd zplisobi, ze vystup ze senzoru je ve skutenosti kombinaci vice signdlli (Ruckay,
2014). Analyza nezavislych komponent je metoda separace signall, ktera oddéluje
smichané nezavislé signaly. Po spusténi nastroje Analyza nezavislych komponent vznikne
takovy pocet nezavislych signall, kolik je senzorti. Pivod signali lze vizualizovat
pomoci nastroje Mapové odstranéni komponent (Tools > Reject data using ICA > Reject
components by map) (obr. 10). Vizualizovana je lokace ptivodu jednotlivych nezavislych
komponent, pfi¢emz Cervena barva zna¢i ohnisko puvodu. V obecné roviné plati, pokud

4 Reject components by map - pop_selectcomps() (dataset: nazev_dataset) — O >

Set thre See com | See proj |

Obr. 10: Vizualizace nezavislych komponent (zdroj: vlastni zpracovani autora, 2017).

je poloha ohniska blizko nosu, jedna se o artefakt vznikly mrkanim. Takovou
komponentu je tedy vhodné odstranit. Nicmén¢ 1 V tomto piipadé plati, Ze rozpoznani
typl a pivodu nezavislych komponent vyZaduje expertni znalost problematiky
(Decomposing data using ICA, 2016).

Naslednym krokem po analyze nezavislych komponent je odstranéni kolisani nulové
izolinie neboli driftu. Jedna se o jev, pfi kterém se dlouhodobé posouva uroven nulové
hladiny, coz mé za nasledek zkresleni signalu (Prochdzka, 2015). Tento problém lze
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odstranit pomoci nastroje Odstranéni pruméru (Tools > Remove baseline), ktery odecte
od signalu jeho primérnou hodnotu (Decomposing data using ICA, 2016).

Rozdilna vlnova pasma nesou riznou charakteristiku dat (Lahane a kol., 2015).
Z toho divodu byla dal$im krokem filtrace dat dle vinovych pasem 9, 6, a, p a y. Hrani¢ni
hodnoty frekvenci vlnovych pasem byly pfevzaty od Morané (1995) (viz kapitola 3.1).
Pro filtraci dat je v toolboxu EEGlab nastroj Zdkladni FIR filtr (Tools > Filter the data >
Basic FIR filter). V ném se zadavaji dolni a horni hranice vlnovych pasem. Filtraci je
nutné na datasetu provést pétkrat, pro kazdé vinové pasmo zvlast, ¢imz vznikne pét
novych datasett.

Vyslednych pét datasetti je potiebné z toolboxu EEGIlab vyexportovat. Pro export
slouzi nastroj Data a ICA do textového souboru (File > Export > Data and ICA activity to
text file). Vzhledem k pozadavkiim na strukturu souboru, vzhledem k dalSimu kroku
prace, bylo nutné pfi exportu nastavit transponovani struktury vysledného souboru, nebot’
nativné¢ toolbox EEGlab exportuje data do fadku, nikoliv sloupcil.

Vystupem z piedzpracovani dat je pét textovych souborl pro kazdého uzivatele
a kazdy stimul. Vzhledem k ofekdvanému vysokému objemu dat bylo nutné proces
ptedzpracovani automatizovat. Vyhodou automatizace je znacna uspora ¢asu, nevyhodou
pak je nemoznost manualni korekce dat v krocich Vizudlni odstranéni dat a Mapové
odstranéni komponent. VVzhledem Kk nizké erudici v oblasti elektroencefalografie bylo od
manudlnich tkonl upusténo ve prospéch automatizace.

Ukony v toolboxu EEGlab lze provadét i bez GUI pomoci skriptil. Skripty jsou ve
formatu skriptovaciho jazyku pouzivaném v softwaru Matlab. Pro tvorbu skriptl velmi
dobie slouzi nastroj UlozZit historii skriptu (File > History Scripts > Save session history
script), ktery vyexportuje skript vSech provedenych ukont, které uzivatel v toolboxu
EEGlab vykonal. Pravé skript, obsahujici vétSinu tkont popsanych v této kapitole,
poslouzil automatizaci piedzpracovani dat (obr. 11).

‘[ALLEEG EEG CURRENTSET ALLCCOM] = eeglab: % sopudtéEni toolboxu EEGlab|

EEG = pop lmportdata

('dactaformac',"ascii', "nbchan',0, 'data’, 'absolutni cesta souboru',

'setname', '=eq’, 'srate’, 250, 'pnts', 0, "xmin',0); % nahréni textového souboru s EEG daty

[ALLEEG EEG CURRENTSET] = pop_newset (ALLEEG, EEG, 0,'gui','off'");

EEG = eeg_checkset( EEG );

EEG = pop_runica(EEG, "extended',l1,’'interupt',’on'); % spu3tiEni nastroje ICR

[ALLEEG EEG] = eeg_store (RLLEEG, EEG, CURRENTSET):

EEG = eeg_checkset| EEG );

EEG = pop_rmbase( EEG, [0 3484]); % spudténi nastroje na odstranéni kolisani nulové izolinie
[ALLEEG EEG] = eeg_store (RLLEEG, EEG, CURRENTSET):

EEG = pop eegfiltnew(EEG, 0.5, 4, 1650, O, [], 1): $ filtrace do pasma delta

[ALLEEG EEG CURRENTSET] = pop_newset (ALLEEG, EEG, 1,'s
EEG = pop_eegfiltnew (EEG, 5, 8, 414, 0, [], 1): %
[ALLEEG EEG CURRENTSET] = pop_newset (ALLEEG, EEG, 2,'setn
EEG = pop_eegfiltnew (EEG, 3, 13, 368, 0, [1, 1): *
[ALLEEG EEG CURRENISET] = pop newset (ALLEEG, EEG, 3,'setnams

Obr. 11: Ukazka skriptu pro praci v toolboxu EEGlab (zdroj: vlastni zpracovani autora,
2017).

4.2.3 Extrakce charakteristickych rysu

Krokem nésledujicim po predzpracovani dat se stala analyza dat. Hlavnim cilem
analyzy dat bylo extrahovat charakteristické rysy signali. Takovym charakteristickym
rysem signalu je tzv. vykonové spektrum signalu (power spectral density, zkr. PSD)
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(Vidaurre a kol., 2012; Al-Fahoum a Al-Fraihat, 2014). Postupné kroky v této kapitole
smefuji k vypoctu PSD. Veskeré vypocty faze analyzy dat byly vyluéné provadény
V softwaru Matlab. Pro vypocty by analogicky mohl byt pouzit i1 jiny software uréeny pro
matematické vypocCty a statistickou analyzu, napt. kterykoliv frontend s grafickym
rozhranim zalozeny na programovacim jazyku R. I pfes fakt, ze oproti softwaru Matlab je
postupu diplomové prace v jednom softwarovém prostiedi.

Prvnim krokem po nahrani dat do prostiedi Matlab je rychla Fourierova transformace
(FFT). Fourierova transformace je zakladnim nastrojem pro zpracovani signali. Smyslem
Fourierovy transformace je pfevod signalu z ¢asové domény na frekvencni doménu
(obr. 12) (Power spectra, 2017). Rychla varianta transformace se nazyva rychla
Fourierova transformace. V softwaru Matlab odpovida rychlé Fourierové transformaci
funkce fft.

FT

casova doména __) frekvenéni doména

s(t) S(w)

Obr. 12: Princip Fourierovy transformace (zdroj:
http://mriquestions.com/uploads/3/4/5/7/34572113/3311485_orig.gif, 2017).}

Po vypoctu rychlé Fourierové transformaci je mozné na datech vypocitat vykonové
spektrum signalu. Vykonové spektrum odpovidd na otdzku, které frekvence daného
signalu obsahuji vykon signalu (Power spectra, 2017). Jinymi slovy, vykonové spektrum
je funkce, ktera nam fika, jaka ¢ast vykonu je nesena jakymi frekvenc¢nimi slozkami.
Vykonové spektrum se udava ve wattech na hertz. Matematicky je vykonové spektrum
vyjadieno jako druha mocnina hodnoty frekvence ve frekvenéni doméné (Power spectra,
2017).

Doposud probihaly vypocty takovym zpisobem, ze kazdy EEG signal vystupujici
Z ptedzpracovani, je v prostiedi Matlab reprezentovan matici. Vzhledem k zavére¢nému
kroku celého postupu praci, jimz byla klasifikace dat, bylo nutné kazdy EEG signal
pievést na jedno Cislo, nebot’ pouzity klasifikator nemél moznost pouzit celou matici,
jako charakteristiku daného signalu. Z toho divodu byla z vykonového spektra

> upraveno
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vypocitdna jeho pramérna hodnota. Tato hodnota pak reprezentovala hlavni
charakteristiku signalu pii zavérecné klasifikaci dat.

Vyse sepsané kroky je nutné opakovat pro kazdého tucastnika a kazdy stimul
experimentu. Vzhledem k velmi vysokému po¢tu vstupnich soubori (pro kazdy stimul
a ucastnika pét souborti s EEG daty rozdé€lenych do vlnovych pasem o, 0, a, B, v)
anutnosti opakovat proces pro kazdy soubor zvlast, byl proces extrakce
charakteristickych ryst opét pieveden do podoby skriptu za ucelem automatizace
procesu.

4.2.4 Klasifikace dat

ZaveéreCnym krokem celého zpracovani dat se stala klasifikace dat. Smyslem
klasifikace bylo roztfidéni charakteristickych rysit EEG dat do klasifikacnich tfid.
Klasifikace probihala v aplikaci Classification Learner, coz je aplikace implementovana
v softwaru Matlab. Pravé integrita aplikace v softwaru, jenz byl pouZzivan pro vétsinu
praci pfi zpracovani diplomové prace, byla hlavnim divodem pro jeji pouziti, ackoliv

Vzhledem kreSersi bylo zvoleno pouziti klasifikatoru Support Vector Machine
(SVM) (Aguinaga, 2015; Candra a kol., 2015; Hidalgo-Muiioz a kol., 2013; Inventado
akol., 2011; Lahane a kol., 2015; Liu a kol., 2010; Schaaff, 2008; Slanzi a kol., 2016;
Sreeshakthy a Preethi, 2016; Strakos, 2016). SVM je metoda strojového uéeni s ucitelem,
ktera se pouziva zejména pii klasifikaci a regresni analyze. Principem SVM je hledani
nadroviny, ktera rozdéluje klasifika¢ni tfidy takovym zpiisobem, Ze mezi nadrovinou
a hrani¢nimi body klasifikacni tfidy je nejvétsi vzdalenost (obr. 13). Nadrovinou se
rozumi pro n-dimenzionalni prostor jakykoliv jeho podprostor o dimenzi n — 1. Pro
rovinu (2D) je tedy nadrovinou piimka (1D), (Wikipedia, 2015).

X,

Obr. 13: Optimalni nadrovina u linedrniho SVM (zdroj:
Wikimedia Commons, 2015).
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Aplikace Classification Learner obsahuje celkem S$est ruznych typu SVM
klasifikatort — linearni, kvadraticky, kubicky a tfi gaussovské. Kromé SVM klasifikatort
muze klasifikace v aplikaci Classification Learner prob&hnout i pomoci rozhodovacich
stromil, diskriminac¢ni analyzy ¢i metody k-nejblizsiho souseda. Velkou vyhodou aplikace
je, ze vSechny typy klasifikace mohou byt spustény najednou a uzivatel aplikace si pak
vybere, ktera klasifikaéni metoda je pro jeho potfeby nejvhodnéjsi.

Zacatkem klasifikace je tvorba klasifikaéniho modelu, tedy sady pravidel, podle
kterych klasifikator bude rozhodovat, jakym zptisobem rozdélovat data do klasifikanich
ttid. Tvorba klasifikacniho modelu je soucasti procesu trénovani dat. Pro trénovani dat
Vv prostiedi Matlab je nutné mit data pfipravena v jedné tabulce, resp. matici. Matice musi
byt strukturovdna do podoby, kdy v tadcich jsou prvky uréené ke klasifikaci a ve
sloupcich jsou atributy téchto prvki. V piipadé¢ ptredkladané prace jsou atributy
reprezentovany prumérnou hodnotou vykonového spektra signdlu pro kazdy senzor
akazdé vinové pasmo. Soucasi matice také musi byt atribut, ktery obsahuje hodnoty
klasifikacnich tfid. V tomto atributu je kazdému prvku ptifazena klasifikac¢ni ttida, do
které prvek spadd. Do trénovéni tedy vstupuje matice, kterd v pfipad¢ této prace ma
celkem 71 atributd (14 senzorl x 5 vlnovych pasem + klasifika¢ni tridy).

Pfed samotnym trénovanim umoziuje aplikace Classification Learner nastavit
ktizovou validaci. Princip kiizové validace spoCiva vtom, ze trénovaci data jsou
rozdélena na k ¢asti. Trénovani a tvorba klasifika¢niho modelu poté probiha na vsech
castech, kromé jedné, na které se otestuje presnost modelu. Tento proces probiha
opakovan¢, ovSem meni se testovana cast (Arlot a Celisse, 2010). Proces kiizové validace
slouzi jako ochrana pro pretrénovani dat, coz je stav, pfi kterém je klasifikator natrénovan
na trénovaci data, ale neni schopen Usp&sné klasifikovat neznama data (Strakos, 2016).

Po natrénovani dat je vytvofen klasifikatni model, ktery je poté pouZivan pro
klasifikaci dalSich dat. Klicovym ukazatelem schopnosti klasifikatoru je jeho Uspésnost
vyjadiena v procentech.

4.3 Experiment se stimuly IAPS

Prvnim planjovanym experimentem byl ten, ktery obsahoval obrazky z databaze IAPS
(International Affective Picture System). Smyslem experimentu bylo ovéfit navrzenou
metodiku a zjistit, zda jsou data potfizena headsetem Emotiv EPOC+ tspésné
zpracovatelna.

IAPS je systém vyvijeny a Sifeny z University of Florida, kde sidli Centrum pro
emoce a pozornost amerického Narodniho institutu duSevniho zdravi (National Institut of
Mental Health, Center for Emotion and Attention). Systém je vyvijen za telem
poskytnout emo¢ni hodnoceni pro velkou sadu mezinarodné srozumitelnych, barevnych
fotografii, které obsahové zahrnuji $iroké spektrum sémantickych kategorii (Lang a kol.,
2008). Vzhledem k rozsahlym experimentiim, které se na Floridé provedly, mize byt
0 obrazcich feceno, jaké emoce by mély u jejich pozorovatelii navodit. Tyto emoce je
mozné odvodit ze tfi ukazatelt, které byly pii experimetech hodnoceny. Ukazatelé
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odpovidaji tfem dimenzim z emo¢niho modelu PAD State Emotional Model (viz
kapitola 3.2.1). Konkrétn¢ se jedna o dimenze arousal (zaujeti, vzruSivost), valence
(pozitivita) a dominance. Poskytnuti databaze IAPS je bezplatné, stat¢i pouze zaslat
zé4dost na institut. Pouziti stimulli z databaze je vyhradné pro studijni a vyzkumné ucely.
Neni povoleno vyuzivat databazi pro komercni ucely a je zakazano poskytovat jakykoliv
stimul z databaze tfetim stranam, zejména médiim, je zakazana publikace i ve védeckych
Casopisech ¢i jejich publikace na internetu.

Hlavni myslenkou experimentu bylo, Ze Gc€astnikiim bude promitnuta sada obrazkl
z databaze IAPS a vzhledem k faktu, Ze jsou u nich zndmé hodnoty dimenzi
reprezentujici emoce, bude mozné k t¢tmto hodnotdm piifadit EEG tucastnikd. Toto
spojeni pak bude figurovat jako sada trénovacich dat, ze které se vytvofi klasifikacni
model pro zavéreCnou klasifikaci. Na zakladé takového modelu pak bude mozné
klasifikovat emoce ucastnika, kterému bude promitnut kartograficky stimul, jenzZ ma
nezndmé hodnoty emoci.

Sestaveni experimentu

Ptiprava experimentu obsahovala zejména vybér stimuld z databaze IAPS, kterych je
celkem 1 182. Pro ucely experimentu byly stimuly rozdéleny do Sesti kategorii. Kritérii
pro rozdéleni se staly hodnoty dimenze arousal a valence, dimenze dominance nebyla
zohlednéna. Hodnoty jednotlivych dimenzi se pohybuji vrozmezi 1-9, piiCemz
pfedstavuji aritmeticky primér z méfeni emoci na University of Florida. Zkazdé
kategorie bylo do experimentu vybrano deset stimulll. Stimuly byly vybrany takovym
zpusobem, pfi kterém byly postupné sefazeny dle obou zkoumanych dimenzi. Z potradi
dimenzi. Pfi takovém zplsobu vybéru byla jesté zohlednéna sémantické skladba stimuli,
pfi¢emZ tematicky se opakujici stimuly byly vyménény za tematicky odli$né, nicméné

9
8
vysoka arousal vysok4 arousal
nizka valence vysoka valence
6
S
El stredni arousal stiedni arousal
g nizka valence vysoké valence
4
3
2
nizka arousal nizka arousal
nizka valence vysok4 valence
1
0

0 1 2 3 4 5 6 7 8 a
valence

Obr. 14: Ptiblizné vymezeni kategorii stimull (zdroj: vlastni
zpracovani autora, 2017).
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s podobnymi hodnotami dimenzi arousal a valence. Takovd vyména stimul probihala
zejména u stimulll s explicitnim obsahem (fotografie mrtvol, fotografie obsahujici plnou
nahotu). Vymezeni jednotlivych kategorii s pifibliznymi hodnotami dimenzi arousal
a valence znazornuje obr. 14. Seznam pouzitych stimull v experimentu véetné veskerych
udaju je k diplomové praci pfiloZen jako pfiloha 2. Kromé stimuld z databaze IAPS byly
do experimentu zaclenény i snimky obsahujici mapy. Jelikoz smyslem experimentu bylo
pievazné zjistit, zda pohled na mapu probouzi v pozorovateli né¢jaké emoce, které jsou
meéfitelné pomoci EEG, nebyla sada snimkt obsahujici mapy nijak tematicky zaméiena ¢i
ucelena. V experimentu se tak vyskytly napi. vyfez geologické mapy CR, vyiez
uzemniho planu, planek autokempu, dvoustrana tematickych map o Africe, plan
londynského metra & Quittova mapa klimatickych oblasti CR. Celkem bylo do
experimentu zaclenéno 80 stimuli, z ¢ehoz bylo 20 stimul obsahujici mapy a 60 stimuld
z databaze IAPS.

Stimuly mély v experimentu pevné poradi, nebyly tedy ucastnikim experimentu
promitany nahodné. Pofadi bylo vybrano takovym zpisobem, aby dva stimuly z databaze
IAPS, klasifikované do stejné kategorie, nebyly promitnuty za sebou. Stimuly obsahujici
mapy byly rozprostiené do celé délky experimentu. Vzdy po Sestici stimulli z databaze
IAPS nasledovala dvojice stimulli s mapami. Mezi kazdy stimul byl vloZen snimek
s ¢ernym kiizkem uprostied na bilé ploSe, ktery slouzil pro centralizaci ucastnikova
pohledu na stfed monitoru. Pro cely experiment bylo nastaveno automatické ¢asovani
snimkii, GcCastnik tedy nemusel obsluhovat posun mezi stimuly mysi ¢i klavesnici.
Stimuly byly promitany na monitoru po dobu 3 500 ms, snimky s kiizky po dobu 500 ms.

Prubéh experimentu

Po sestaveni experimentu piiSlo na fadu samotné testovani, které probihalo v eye-
tracking laboratofi na katedfe geoinformatiky. Experimentu se zcastnilo 15 osob ve
véku 21-45 let, z toho 12 muzt a 3 Zeny. VSichni Gcastnici jsou studenti ¢i zaméstnanci
katedry geoinformatiky Univerzity Palackého v Olomouci.

Po usazeni Gcastnika pted eye-tracker nasledovala instruktdZ operatorem experimentu
(autor piedkladané prace). Ucastnikovi byla detailné popsana jeho role v experimentu.
Vzhledem k ¢astecné explicitnimu obsahu stimulii v experimentu, byl ucastnik na tento
fakt pfedem upozornén. Dlvodem takového upozornéni bylo omezeni piekvapivych
ucastnikovych reakci, zejména reflexivni odvraceni pohledu mimo obrazovku, zakryti si
o¢i apod., coZ by mélo za nésledek vneseni Sumu a artefaktii do méfenych dat, pficemz
tyto by se staly pro dal$i zpracovani nepouzitelné. Po tomto upozornéni a ujisténi, ze
ucastnik rozumi své Ucasti v experimentu, byl ucastnik pozadan o potvrzeni formulafe
informovaného souhlasu (viz Pfiloha 1). Ziskanim potvrzeného informovaného souhlasu
mohla zacit instalace EEG zatfizeni na ucastnikovu hlavu. Instalace probihala stejnym
zpusobem, jako je popsana v kapitole 4.2.1.

Nasledovalo jiz samotné spusténi experimentu. Na za¢atku ucastnik vyplnil zakladni
nacionale, konkrétné¢ se jednalo o jméno, pohlavi a vék. Poté jiz byly ucastnikovi
promitany samotné stimuly. Jak jiz bylo zminéno, jednalo se o 80 stimuld, které se samy
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promitaly. U€astnik nemusel posouvat stimuly manualné z diivodu, aby nedochazelo
k vnaseni Sumu a artefakti do méfeného signalu. Pii prubéhu experimentu bylo naprosté
ticho, operator nijak do experimentu nevstupoval, aby ucastnik nebyl nijak vyrusovan
a pusobily na néj pouze promitané stimuly.
Dotaznik SAM

Druhou c¢asti experimentu se stal dotaznik SAM (The Self-Assessment Manikin).
Jedna se o nonverbalni metodu, pfi které tcastnici pomoci piktogrami hodnoti, jakym
emoc¢nim prozitkem na né plisobi stimul (Bradley a Lang, 1994). Zakladnim stavebnim
kamenem dotazniku je sada piktogramt ur¢ena pro méfeni emocnich dimenzi valence,
arousal a dominance. Vzhledem k potiebam ptedkladané prace byly pouzity piktogramy
pouze pro dimenze valence a arousal (obr. 15).

Obr. 15: Piktogramy pro dotaznik SAM (zdroj: Bradley a Lang, 1994)

Piktogramy se snazi pomoci vizudlni podoby asociovat pocitovanou emoci.
Oznacenim pfislusného piktogramu Uc€astnik experimentu sebehodnoti pravé prozivanou
emoci. Horni fada piktograml slouzi pro ohodnoceni dimenze arousal, kdy na pravé
stran¢ je jeji nejniz8i hodnota a na levé strané nejvyssi. Muze byt feceno, ze piktogram
V horni fad€ na pravé stran¢ piedstavuje pocit velmi nizkého vzruSeni ¢i nizkého zdjmu
oproti tomu piktogram na levé stran¢ ptredstavuje velmi vysoké vzruSeni ¢i zaujeti. Ve
spodni fad¢ se potom hodnoti emoc¢ni dimenze valence. Na pravé strané se nachézi
piktogam s nejniz$i mirou valence predstavujici velmi negativni pocit. Na opacné strané
je piktogram snejvys$si mirou valence predstavujici velmi pozitivni pocit. Prazdné
obdelniky vyskytujici se mezi jednotlivymi piktogramy piedstavuji také moznost
ohodnoceni dané dimenze. Oznaceni obdélniku slouzi v ptipadech, kdy se ucastnik
nemize rozhodnout v oznaceni mezi dvéma sousedicimi piktogramy.

Pro potieby dotazniku SAM byl vytvotfen druhy kombinovany eye-tracking a EEG
experiment. V ném byly stejné stimuly jako v experimentu prvnim a to ve stejném poradi.
Rozdily oproti prvnimu experimentu mohou byt nalezeny zejména ve skute¢nosti, Ze nyni
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u stimulii nebylo nastaveno automatické ¢asovani, Gi€astnici si mohli stimuly prohliZet
libovolné dlouho, a po kazdém stimulu nasledoval snimek s dotaznikem SAM v podobé
jako na obr. 15.

Ukolem uéastnikii bylo prohlédnout si znovu stimuly a poté zhodnotit své pocity
vychdzejici znich a tyto zaznamenat kliknutim kurzorem mysSi na jeden piktogram
V horni fadé hodnotici dimenzi arousal a jeden piktogram v dolni fadé hodnotici dimenzi
valence. Pro tyto tikony byli u€astnici pfed druhou ¢asti experimentu instruovani. Byl jim
detailn¢ popsén princip dotazniku i s uvedenim ptikladu. I pies tento fakt, dochazelo
v ojedinélych pfipadech bud’ k nechténému pieskoceni snimku s dotaznikem, nebo
k mnohonasobnému ohodnoceni jedné dimenze. V takovém ptipadé bylo v nasledujicim
zpracovani dat zohlednéno pouze prvni ohodnoceni dané¢ dimenze, na ostatni ohodnoceni
nebyl bran zfetel.

I pres skutecnost, Ze 1 pii této Casti byla Ucastnikim méfena EEG data, tato nebyla
dale zpracovavana, a to z n¢kolika divodi. Prvnim divodem byla nestejnorodost v délce
prohlizeni stimuli. Vzhledem k tomu, ze ucastnici méli moznost si pii dotazniku SAM
prohlizet stimuly libovolné dlouho, bylo by obtizné néasledné sjednotit ¢asové udaje pro
vSechny stimuly. Druhym divodem se pak stalo prosté snizeni kvality pfenosu signalu.
S piibyvajicim cCasem hydratované senzory na EEG headsetu kvuli vlasim zacaly
postupné¢ vysychat, ¢imz kvalita pfenosu signdlu zakonit¢ zacCala klesat. Sundani
headsetu, hydratace senzorti a opétovna instalace by zabrala dalsi ¢as. Jiz v takovéto
podobé experimentu zabrala celd procedura ptiblizné¢ 30 minut na ucastnika, ktery po
zhlédnuti 160 stimuli byl ve vétSiné ptipadii unaveny. Tietim divodem, ktery nelze
opomenout je fakt, Ze ucastnici vykonavali pii této Casti experimentu drobné pohyby,
¢imz v signalu piibyl Sum a artefakty. Smysl méfeni EEG pii dotazovani SAM byl
zejména pozorovaci.
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5 VYSLEDKY

V této kapitole jsou piehledné shrnuty dosazené vysledky v praci. Kromé popisu
vysledku je i reflektovan fakt, zda bylo dosaZeno cili uvedenych v kapitole 1. Tato
kapitola je rozd€lena do tfi Casti, pfiCemz v prvni je shrnuta navrhovana metodika pro
meéieni a zpracovani EEG dat, ve druh¢ jsou popsany vysledky provedené¢ho experimentu
se stimuly z databaze IAPS a ve tieti je rozebrano, pro¢ nebyl uskute¢nén dalsi
experiment.

5.1 Metodika méfeni a zpracovani EEG dat

Hlavnim cilem predkladané prace, jak je uvedeno v Kapitole 1, je pouziti zatizeni
EEG Emotiv EPOC+ pii kombinovaném eye-tracking a EEG experimentu s eye-
trackerem SMI RED 250. Pro provedeni takového experimentu bylo nutné nejdiive
ustanovit metodiku. Ta je detailn€ popsana v kapitolach 4.2.1-4.2.4. Obsahuje Ctyii Casti
— méfeni dat, predzpracovani dat, extrakci charakteristickych ryst a klasifikaci dat,
pficemz méfeni dat bylo provedeno v softwaru SMI ExperimentCenter™ Software,
pfedzpracovani dat probihalo v toolboxu pro Matlab s nazvem EEGLAB a extrakce
charakteristickych rysi spole¢né s Klasifikaci probihalo v softwaru Matlab a jeho
zabudovanych aplikacich. Z vySe uvedeného vyplyva, ze dil¢i cil sestaveni metodiky pro
kombinovany EEG a eye-tracking experiment a nasledné zpracovani namétenych dat byl
splnén.

5.2 Vysledky experimentu se stimuly IAPS

Cil experimentu by se dal rozdélit do dvou ¢asti. Prvni ¢asti bylo ziskani a zpracovani
dat z EEG headsetu. Druhou ¢asti pak bylo provedeni dotazovani pomoci dotazniku SAM
a ziskané vysledky porovnat s daty z EEG.

Naméfenim EEG dat zapocal postup praci, ktery je detailné popisovan v kapitolach
422,423 a4.2.4. Celkem byla naméfena data od 15 ucastnikti, kazdému z nich bylo
promitnuto 80 stimull, coz dohromady tvofilo 1200 textovych soubord nutnych ke
zpracovani. Po pfedzpracovani dat, pii kterém se mj. data filtrovala do péti vinovych
pasem, bylo vytvoieno 6000 textovych souborti, které vstupovaly do procesu extrakce
charakteristickych rysi. Pro zavérecné trénovani dat bylo nutné vybrat pouze data od
stimuli z databaze IAPS. Trénovani dat probihalo stejnym zpiisobem, jako je popsano
v kapitole 4.2.4, pticemZ bylo nastaveno Sest klasifikacnich kategorii odpovidajicim
rozdéleni na obr. 14. Pfi trénovani byla nastavena desetinasobnd ktizova validace. Pro
trénovani byly krom&€ SVM Kklasifikatori spuStény 1 klasifikatory diskrimina¢ni analyzy
k-nejblizs§iho souseda a rozhodovacich stromd, nejvétsi duraz byl ovSem kladen na
klasifikatory typu SVM. Hodnocenym vysledkem se v pfipad¢ trénovani dat stal
klasifikaéni model, ktery vznikl trénovanim dat a ktery uddva procentudlni uspesnost,

vvvvvv

modelu bylo dosazeno pravé pii nastaveni desetinasobné kiizové validace a pouziti

40



linedrniho klasifikatoru SVM. Uspé&snost tohoto modelu oviem ¢&inila pouhych 19,7 %.
Uspé&$nost miize byt graficky zndzornéna pomoci konfiizni matice (obr. 16), ve které jsou
zobrazeny hodnoty ptesnosti klasifikatoru s ohledem na vSechny klasifikované prvky.
Cisla uvedena v matici na zeleném podkladu udavaji pocet prvki, které byly uspésné
predikované do urcité klasifikacni tfidy. Oproti tomu ¢isla uvedena v matici na ¢erveném
podkladu znac¢i pocCet prvkl, které byly pii trénovani dat klasifikovany do jiné
klasifika¢ni tiidy, nez jaka byla prvkim predikovana. V idedlnim ptipadé je tedy
rozlozeni prvkil zejména na hlavni diagonale.
Konfuzni matice
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Obr. 16: Konfuzni matice pro $est klasifika¢nich t¥id (zdroj: vlastni
zpracovani autora, 2017).

Vzhledem k ziskani klasifika¢niho modelu s pfesnosti klasifikace necelych 20 %,
doSlo nasledné k dal$im pokusiim trénovani dat za ucelem zvysit presnost klasifika¢niho
modelu. Ale i pies nékolikeré zmény nastaveni hodnoty pfti kiizové validaci ¢i sniZeni
objemu dat vstupujicich do procesu trénovani, nedoslo ke zvySeni pfesnosti
klasifika¢cniho modelu. U ostatnich typt klasifikatord, které byly také spousStény pfi
trénovani dat, nedosahovala ptesnost vzniklych klasifika¢nich modell statisticky
vyznamného vylepSeni. Pokud byla hodnota ptesnosti klasifika¢niho modelu vyssi, nez
u klasifikatort typu SVM, rozdil byl maximialné v fadu desetin procenta.

Dal$im krokem, ktery mohl zvednout procentudlni piesnost modelu, byla redukce
poctu klasifikanich kategorii. Pii tomto kroku byl pocet kategorii snizen na dvé.
Z dvoudimenzionalniho Kruhového modelu Jamese Russella byla zcela opomenuta
dimenze arousal a zachovana byla pouze dimenze valence, kterd byla rozdélena na
pozitivni a negativni. Do téchto dvou kategorii byly prekategorizovany data ze stimuld
z databaze IAPS. Pfi tomto nastaveni s desetindsobnou kiizovou validaci dosahl nejvyssi
presnosti linearni klasifikdtor SVM a to 54,2 %. Ani tato hodnota nepiisobi pfilis
pozitivng€, pokud se vezme v potaz, Ze se jednalo o pfesnost klasifikacniho modelu
obsahujici pouze dv¢ klasifikacni tfidy. Pokud ma binarni klasifikator pfesnost 50 %,
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jedna se o tzv. nenauceny klasifikator, coz znamena, Ze klasifikuje prvky naprosto
nahodné.

V druhé casti experimentu ucastnici vypliovali dotaznik SAM. Dal§im vysledkem
experimentu jsou tedy odpoveédi ucastnikli, které lze zpracovat do podoby grafu, ve
kterém jsou jednotlivé osy piedstavovany dimenzemi valence a arousal (obr. 17). V grafu
jsou, kromé =zanesenych odpovédi, zobrazeny i zprimérovana hodnota odpovédi
ucastnikl a také referencni primér pro dany stimul, ktery byl ziskan spolecn¢ se stimuly
Z University of Florida. Takovymto zpiisobem lze vizualizovat veSkeré odpovédi

Stimul &. 18 @ odpovedi Géastnikl

o Py P primér odpovéd
referenéni primér
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Obr. 17: Graf zobrazujici odpovédi ti€astnikt na dotaznik SAM u stimulu €. 18 (zdroj:
vlastni zpracovani autora, 2017).

Z dotazniku SAM, véetn€ odpoveédi na stimuly, které nepochazely z databaze IAPS.
U grafil, které zobrazuji odpovédi na stimuly nepochdzejici z databaze IAPS, je rozdil
Vv tom, ze neobsahuji bod reprezentujici referenéni pramér.

Pro dalsi préci s dotaznikem SAM bylo nutné zjistit, zda odpovéedi ti€astniki reflektuji
referencni pramér a zda tedy tato metodika je validni a pouzitelnd 1 pro hodnoceni jinych
stimuli. Pro zhodnoceni uspéSnosti dotazniku SAM bylo pouzito porovnani hodnot
pruméru odpovédi ucastnikli s hodnotou referen¢niho priméru formou vypocitani
prumérné vzdalenosti téchto bodd v grafu u vSech stimuli pochazejicich z databaze
IAPS. Vzdalenost bodi A [Xa, Ya] @ B [Xs, Ys] reprezentujici praméry byla vypocitana
formou euklidovské vzdalenosti:

4l = (Gimm s (y-y,) @

Jak je patrné z tab. 2, tak primérna hodnota této vzdalenosti je cca 1,28, coZ v roviné
s maximalni hodnotou 9 dél4 piiblizné 14,22 % délky této roviny. Miize byt tedy feceno,
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7ze piesnost odpovédi ucastnikii experimentu se pfiblizn¢ z 85,78 % shodovala
s referen¢nim priimérem poskytovanym vlastnikem a autorem dotazniku SAM.

Tab. 2: Vzdalenosti primérnych odpovédi a referenénich pramérd u stimulll z databaze IAPS (zdroj: vlastni
zpracovani autora, 2017).

¢ primér odpovédi [referencni priimér| vzdalenost
"| valence | arousal | valence |arousal| primérd
1| 3,27 5,73 1,95 4,53 1,78
2| 6,13 3,13 7,14 3,00 1,02
3 7,20 4,67 8,28 4,10 1,22
4] 6,47 5,73 7,73 6,65 1,56
5| 2,07 7,40 1,66 6,04 1,42
6 4,60 1,87 4,43 2,55 0,70
9] 3,33 4,93 2,56 4,61 0,84
10| 4,47 3,27 4,45 2,51 0,76
11] 7,40 5,20 8,03 4,60 0,87
12| 6,40 4,80 7,63 6,07 1,77
13 6,07 3,13 6,51 2,74 0,59
14 2,73 7,13 1,83 6,08 1,39
17] 4,73 3,27 4,25 2,95 0,58
18] 2,27 6,40 1,76 6,81 0,65
19 3,40 5,87 2,58 4,95 1,23
20 7,00 5,33 8,00 4,92 1,08
21 593 2,47 7,08 2,67 1,16
22] 7,00 4,27 7,38 6,28 2,05
25| 4,60 2,07 4,55 2,27 0,21
26] 6,47 4,40 6,50 2,60 1,80
27] 7,80 6,40 8,10 6,28 0,32
28] 2,13 7,73 1,46 7,21 0,85
29] 7,07 4,60 7,90 4,27 0,90
30| 3,20 6,00 2,20 4,88 1,50
33| 6,27 3,87 7,14 2,90 1,30
34| 1,93 7,87 1,45 6,41 1,53
35| 2,87 6,20 2,56 4,92 1,32
36| 7,13 4,73 8,19 4,61 1,06
37| 4,93 1,67 4,45 2,81 1,24
38| 6,33 5,13 7,57 7,27 2,47
41| 5,67 3,33 6,37 2,83 0,86
42| 453 2,67 4,23 2,96 0,42
43| 6,00 3,27 7,91 6,44 3,70
44| 2,13 7,53 1,51 7,07 0,78
45| 7,07 5,20 7,77 4,68 0,87
46] 3,80 5,73 2,56 4,31 1,89
49| 2,00 7,80 1,31 6,91 1,13
50| 6,67 4,07 6,31 2,79 1,33
51| 5,00 1,80 4,63 2,71 0,98
52| 6,80 4,93 7,77 6,73 2,04
53] 3,27 5,93 2,06 4,00 2,28
54| 6,60 4,93 8,21 4,31 1,73
57] 2,20 6,93 1,69 6,58 0,62
58| 6,67 4,53 8,03 4,90 1,41
59| 3,67 4,93 2,54 4,86 1,13
60] 6,87 5,47 8,02 7,17 2,06
61 6,33 4,13 6,23 2,84 1,30
62| 513 4,13 4,03 2,63 1,86
65| 6,40 4,33 7,74 6,14 2,25
66] 4,73 2,47 4,52 2,03 0,49
67] 3,20 4,80 2,67 4,63 0,56
68] 2,67 4,93 2,04 6,05 1,28
69] 5,47 4,00 6,17 2,90 1,31
70| 7,07 4,73 8,20 4,57 1,15
73] 7,00 4,73 7,35 6,02 1,33
74| 2,67 6,80 2,44 5,00 1,81
75| 6,33 4,53 7,61 4,51 1,28
76| 6,93 4,00 6,36 2,51 1,60
77| 5,27 2,87 4,49 2,63 0,81
78] 2,40 6,27 1,62 7,15 1,18
pramér: 1,28
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Nejvétsich hodnot v rozdilech priméri dosdhly stimuly z kategorie vysoka arousal-
vysoka valence (stimuly €. 4, 12, 22, 27, 38, 43, 52, 60, 65, 73). Pramérna vzdalenost této
dosahly stimuly z kategorie vysoka arousal-nizka valence (stimuly ¢. 5, 14, 18, 28, 34,
44,49, 57, 68, 78). Tato hodnota ¢ini ptiblizné 1,07.

Diky dotazniku SAM, mohou byt s velmi vysokou piesnosti klasifikovany i stimuly,
které nepochdzeji z databaze IAPS, coz jsou v pfipadé této prace stimuly obsahujici
mapy. Primérné hodnoty odpovédi lze opét zanést do grafu spolu s vyznacenymi Sesti
klasifikacnimi kategoriemi, které byly ustaveny v pfedchozich castech (obr. 18).

2 = - g . o . . -
Prumérné hodnoty odpovédi u stimulu s mapami stimul €. 7
g stimul €. 8
@ stimul €. 15
5 stimul €. 16
stimul €. 23
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Obr. 18: Pramérné hodnoty odpovédi u stimulti s mapami spole¢né s vyznacenymi klasifika¢nimi kategoriemi (zdroj:
vlastni zpracovani autora, 2017).
Z vysledného grafu je patrné, Zze vSechny stimuly s mapami vyjma jedné spadaji do
kategorii s vysokou mirou valence, lze tedy fici, Ze pisobily na castniky experimentu
pozitivné. Veskeré mapy kromé tii spadaji do kategorii sttedni miry arousal.

Cilem tvlrct map by mélo byt, aby jejich vysledny produkt plisobil pozitivné a aby
pokud mozno mél co nejvyssi miru arousal, coZ by znacCilo vysokou miru zaujeti
uzivatele vaci produktu. Vysledky z grafu naznacuji uspéSnost tvlrcii stimulli pouzitych
pii experimentu, nebot’ vétSina stimulli pisobila na Gcastniky pozitivné, pficemz jejich
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zaujeti bylo ve vétSing pfipada na stfedni Grovni. Tato skutecnost samoziejmé muize byt
ovlivnéna strukturou ucastnikli experimentu, nebot vSichni pochazeli z katedry
geoinformatiky a daji se tedy oznacit za experty v oboru, kterym jsou mapy blizké.

Nejlepsich hodnot v dotazniku SAM dosahly stimuly ¢. 16, 39 a 64, které ziskaly
nejvetsi ohodnoconi dimenzi valence a arousal. Nejhlife naopak z dotazniku vysly
stimuly €. 15, 32 a 56. VSech Sest stimulii je zobrazeno na obr. 19. Nejlépe hodnocené
stimuly maji spolecné to, Zze se nejedna o mapy v pravém slova smyslu, ale jde
o0 infografiky ¢i designové obrazky u kterych chybi kompozi¢ni prvky map.

Dil¢i cil prace, uvedeny v kapitole 1, provést experiment, na kterém bude
verifikovana navrzend metodika a ktery bude obsahovat stimuly z databaze IAPS, byl
splnén. Z naméfenych vysledki lze doporulit, ze pro méfeni emoci ucastnikl je

vhodnéjsi pouziti dotazniku SAM nez klasifikace emoci z primarnich EEG dat.

Obr. 19: Stimuly €. 16, 39 a 64 (vlevo) a stimuly €. 15, 32 a 56 (zdroj: vlastni zpracovani autora, 2017).

45



5.3 Kartograficky experiment

Soucasti zadani prace a jednim zcild prace bylo i provedeni kartografického
experimentu. Jeho smyslem mélo byt otestovani ucastniki a naméfeni EEG dat pfi jejich
praci s mapami a pfi feSeni jednoduchych prostorovych uloh. Po konzultaci s vedoucim
prace ovSem bylo od tohoto experimentu upusténo a to z nékolika divodd. Prvnim z nich
byla nizka uspésnost klasifika¢niho modelu pii experimentu se stimuly z databaze IAPS,
jenz mél slouzit jako testovaci experiment, ze kterého bude patrné, zda se daji uspésné
klasifikovat emoce z primarnich EEG dat a ze kterého vznikne isp€$na sada trénovacich
dat. Druhym davodem, pro¢ nebyl experiment uskute¢nén, byla skute¢nost, ze pii
takovém experimentu by ucastnici vykonavali pohyb (pfinejmensim ovladani mysi), coz
by, vzhledem K citlivosti EEG headsetu, vnaselo do dat Sum a artefakty. Poslednim
divodem pak byl i potencialné odlisny piistup k experimentu a zpracovani dat. Pii tomto
experimentu by kazdy ucastnik provad€l ukoly rozdiln¢ dlouho, coz by znesnadnilo
zpracovani dat. Vzhledem k tomu, ze béhem daného ukolu by se ucastnikovy emoce
ménily, bylo by nutné data z jednoho ukolu rozdélit do n€kolika ¢asti. Otazkou by bylo,
jak by takové ¢asti mely vypadat. Pokud by doslo k rozdéleni na stejné dlouhé casové
intervaly, mohlo by dojit k situaci, ze ve stejném intervalu bude vice nez jedna emoce.
Casteénym feSenim této situace by bylo vkladani ¢asovych znatek do dat operatorem
experimentu dle zmén emoci ucastnika, ktery by ovSem tyto zmény musel napiiklad
oznamovat nebo by musel cely experiment probihat formou thinking aloud a ucastnik by
hovotil o tom, jak se citi a jaké proziva emoce. V takovém piipadé¢ by ovSem vyvstaly
problémy s tim, Ze ne kazdy je schopny pojmenovat, jak se citi, a v krajnich ptipadech by
to mohlo byt pro ucastnika nepfijemné. Dalsi problém spojeny s mluvenim ucastnikti by
byl narhst Sumu a artefaktd v namétenych datech.

5.4 Manual

Vzhledem K potfebam katedry geoinformatiky a pro zjednoduseni budouci prace se
zafizenim Emotiv EPOC+ byl sepsan 22strankovy strukturovany manual, ktery detailné
popisuje praci s headsetem a nasledné zpracovani EEG dat. Tento manual je pfiloZen
k diplomové praci jako ptiloha 4.

Manual je rozdélen do péti kapitol. V prvni je popsana zakladni Gdrzba headsetu. Ve
druhé kapitole je popsdna metodika métfeni dat, véetné nasazovani headsetu na hlavu
ucastnika pifi experimentu. Treti kapitola popisuje jednotlivé kroky nutné pro
pfedzpracovani dat v toolboxu EEGLAB a ctvrtd kapitola tak cini pro extrakei
charakteristickych ryst v softwaru Matlab. Zavére¢na pata kapitola pak popisuje procesy
trénovani dat a tvorbu klasifikacniho modelu v aplikaci Classification Learner. Podrobna
struktura celého manualu je znazornéna jeho obsahem v kapitole 5.4.1.
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5.4.1

Obsah manualu

1 UDRZBA ZARIZENi EMOTIV EPOC* 4
1.1 NABIJENi HEADSETU 5
12 HYDRATACE HEADSETU 5

2 MERENI DAT 6
2.1 INFORMOVANY SOUHLAS 6
2.2 NASAZENI SENZOR( 6
2.3 SPAROVANi HEADSETU S POGITAGEM 6
2.4 INSTALACE ZARIZENi NA HLAVU 1
2.5 AKTIVACE SENZORU 1
2.6 EXPERIMENT 8

3 PREDZPRACOVANI DAT 9
3.1 IMPORT DAT 9
3.2 NAHRANi SOUBORU .CED 10
3.3 ODSTRANENI ARTEFAKTU 12
34 ANALYZA NEZAVISLYCH KOMPONENT 12
3.5 ODSTRANENi KOLISANi NULOVE IZOLINIE 13
3.6 FILTRACE DO VLNOVYCH PASEM 13
37 EXPORT DAT 14
38 SKRIPT 15

4 EXTRAKCE CHARAKTERISTICKYCH RYSU 16
4.1 IMPORT DAT 16
4.2 FOURIEROVA TRANSFORMACE 17
4.3 VYKONNOVE SPEKTRUM SIGNALU 17
4.4 PROMERNA HODNOTA VYKONOVEHO SPEKTRA 17
45 EXPORT DAT 18
4.6 SKRIPT 18

5 KLASIFIKACE DAT 19
5.1 PRIPRAVA DAT 19
5.2 TRENOVANi DAT 19
5.3 EXPORT KLASIFIKACNiHO MODELU 21
5.4 POUZITi KLASIFIKAGNIHO MODELU 29
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6 DISKUZE

Tématem predkladané diplomové prace je méfeni emoci. Na zaklad¢ ziskanych
vysledkd lze diskutovat, zda postupy méfeni emoci, jez jsou uvedeny V praci, jsou
vhodné, jaké maji pfednosti a jaké jsou jejich nedostatky.

Na zacatku je ovSem tieba polozit obecnou otazku ohledné méieni emoci. Jedna se
0 meéfitelnou veliCinu? Odpovéd’ na tuto otazku je zasadni. Pfi standardnich meétenich
jsou obvykle méteny realné, hmatatelné veliCiny, at’ uz se jedna o vzdalenost, mnozstvi
néco, co neni vidét a neni hmatatelné. Problematice nepfispiva ani fakt, Ze neni
ustanovena zakladni definice emoce, ani preferovany emoc¢ni model. Stejné¢ tak se
ptekryvaji rozdily mezi definicemi emoci, pocitil a ndlad.

Dalsi otazkou ziistava, zda by zkoumdni a méfeni emoci, ve smyslu jaké emoce
vyvolava vysledny produkt, mélo byt doménou kartografli. Zajisté, je vhodné, aby
vysledny kartograficky produkt ptlisobil ptivétivé, pozitivné a pokud mozno co nejvice
zaujal uzivatele produktu. Nicméné€ tyto véci souvisi zejména s celkovym designem
produktu, coz uz se tolik nedotyka samotné kartografie. Pti tvorbé map se vyzkum emoci
muze hodit zejména pii rozhodovani o pouZiti riznych barev, nicméné tim se jiz Gsp&Sné
zabyva obor psychologie barev.

Zajimavym vyzkumem v oblasti kartografie by ovsem bylo, jak slozité je prace ¢i jak
vhodné je ovladani vysledného kartografického produktu. Pro zjisténi takovych udaji by
bylo vhodné méfit lidskou kognitivni zatéZz (angl. cognitive load), jenZ udava celkovy
objem myslenkového usili pouzitého pii pracovni, kratkodobé paméti.

Méfeni emoci pomoci EEG

I pfes obtiZznost méfeni emoci, se ve sveété objevuji noveé pristupy k této problematice.
Ve 21. stoleti a zejména v poslednich péti letech se vyskytla celd fada studii, kterd
ziskava hodnoty emoci z EEG dat. Nikdy se ovSem nejedna o ziskdni konkrétni emoce,
ale pouze o n¢jakou obecnou kategorii emoci. Diky tomu, Ze katedra geoinformatiky
disponuje zafizenim, které méti EEG, mohla byt tato metoda méfeni emoci vyzkousena.
Metoda méfeni emoci pomoci EEG zlstava ponékud konzervativni a to z diivodu vzniku
signalu a misté, kde emoce vznikaji. Zaznamenany EEG signal vznikd zejména diky
aktivité povrchovych struktur mozku (Elektroencefalografie, 2016), zatimco pivod emoci
je v amygdale, jez je soucasti limbického systému a nachazi se az pod mozkovou ktirou.
Kvuli tomuto faktu minimalni pocet studii zabyvajici se klasifikaci emoci z EEG dat
pochézi z medicinského prostredi. VétSinou se jedna o technologicky zaméfené instituty
S dirazem kladenym na IT.

Navrzeny postup zpracovani EEG dat reflektuje vybrané studie. U nékterych studii
byly pouzité jiné hardwary, softwary, transformace ¢i metody klasifikace, coZ je
podrobnéji popsano v kapitole 3.3. Divodem, pro¢ byly vybrany do metodiky prave ty
kroky, které byly vybrany, je zejména softwarové vybaveni. Klicovym softwarem pro
celou praci byl toolbox EEGLAB. Vzhledem k tomu, Ze toolbox EEGLAB lze spustit
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pouze Vv softwaru Matlab, veskeré dalsi kroky byly ¢inény s ohledem na skute¢nost, aby
byly realizovatelné v prostedi Matlab.

Vysledkem zpracovani EEG signalu byl klasifikaéni model, ktery dosahl ptesnosti
klasifikace pouhych 19,7 %. Davodu, pro¢ se dospélo k tak malo pfiznivému vysledku,
muze byt nékolik. Prvnim znich mtze byt chyba méfeni. To se mohlo stat kvuli
chybnému usazeni headsetu na hlavu. Ten neni vic¢i nepfesnému usazeni na hlavu nijak
uzpusoben. Ano, cely headset ma pevné danou pozici senzorii vici sobé navzijem,
nicmén¢ pii nespravné manipulaci s nim, mize byt umistén na hlavu pod rtiznymi thly.
K tspéSnému prenosu signadlu i pfes chybné umisténi dojde. Staci, aby byly senzory
headsetu fadn¢ hydratovany. Dalsi problém, ktery mohl ovlivnit métfeni dat, bylo
postupné vysychani senzord, s ¢imz bylo spojeno postupné snizovani kvality pfenosu
signdlu. I téch pfiblizné 8§ minut, co trval experiment, stacilo v nékterych piipadech
k tomu, aby se na senzoru ztratil signal.

Teoreticky k problémim mohlo dojit i v ¢astech piedzpracovani dat a extrakce
charakteristickych rysa z nich. V tomto ptipadé€, ale doslo k pfevzeti postupt z ostatnich
studii.

Jiného vysledku mohlo byt dosaZeno pii rizném nastaveni trénovani dat a pouziti
odlisného klasifikatoru. Potencidlnich kombinaci feSicich, jak objemny pouzit soubor
trénovacich dat, kolikandsobnou kifizovou validaci nastavit a jaky nejvhodnéjsi
klasifikator pouzit, je velké mnozstvi. Jistou pokrocilejsi moznosti se jevi pouziti
umélych neuralnich siti pro klasifikaci.

I pres skutecnost, Ze se experimentu zucastnilo pouze 15 osob, jevi se toto Cislo jako
nepodstatné pro negativni ovlivnéni vysledki. V citovanych studiich casto do
experimentu vstupovala data od nizSiho poctu ucastnikl, pfi€emz jejich UspéSnost
klasifikace byla vyssi.

Dotaznik SAM

Dotaznik SAM je druha metoda, ktera byla v praci pouzita pro méfeni emoci. Jeho
nejvetsi prednosti je jeho jednoduchost a asociativnost. Také lze o ném fici, Ze je
akceptovany lékarskym prostiedim, nebot’ byl vyvinut v americkém Narodnim institutu
duSevniho zdravi (The National Institute of Mental Health).

Oproti klasifikaci EEG dat dosahly vysledky z dotazniku SAM nepomérné vyssi
ptesnosti. Diky tomu lze vysledky stimulil, které nepochazely z databaze IAPS, ziskané
prostiednictvim tohoto dotazniku povazovat za relevantni.

Co negativné ovlivilovalo provedeni dotazniku SAM byl fakt, Ze experiment
S dotaznikem nésledoval ihned po experimentu, pifi kterém byla méfena EEG data.
Vzhledem Kk vysokému poctu stimuld (80), které Gcastnici vidéli dvakrat po sob¢, byli
ucastnici ke konci experimentu jiZ unaveni a cely proces ohodnoceni emoci urychlovali,
at’ uz védomé ¢i nevédom¢.

Zajimavé je také bliz§i prozkoumani stimulll z databaze IAPS. Z vysledkt v kapitole
5.2 vyplyva, Ze nejveétsi rozdily mezi ocekdvanou emoci ucastnikd a projevenou emoci
byly u stimull z kategorie vysoka arousal-vysoka valence, tedy snimkd, které by mély
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nejvice zaujmout a byt pro ¢lovéka nejvic pozitivni. Divodem, pro¢ zrovna tato kategorie
dosahla nejvétsich rozdilit mezi projevenou a ocekavanou emoci muze byt skutecnost, ze
stimuly jsou proamericky ladéné. Nejvétsiho rozdilu doséhl stimul, na kterém jsou
zobrazeny rozhazené bankovky americkych dolart, coz Cecha ziejmé neovlivni natolik,
jako by ovlivnil stimul, na kterém by byly zobrazeny ¢eské bankovky. Dal§im ptikladem
je stimul zobrazujici americkou gymnastku ve vitézném gestu. Pro Cechy by v takovém
piipadé vhodng&jsi stimul s ¢eskym sportovcem, ktery je vSeobecné znamy a je symbolem

uspéchu.
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7 ZAVER

Motivaci, pro¢ zpracovat praci stimto tématem, se stala pfitomnost
elektroencefalografu Emotiv EPOC+ na katedie geoinformatiky. Hlavnim cilem prace
bylo pouziti zatizeni Emotiv EPOC+ spole¢né s eye-trackerem SMI RED 250 pfi
kombinovaném eye-tracking a EEG experimentu. Dil¢imi cili, nezbytnymi pro dosazeni
hlavniho cile, se staly nastudovani problematiky v oblasti elektroencefalografie, emoci
a zpracovani signalu, navrhnuti metodiky ziskdni a zpracovani EEG dat za tcelem
klasifikace emoci, popis hodnot emoci a primarnich dat vychazejicich z ptistroje Emotiv
EPOC+ a provedeni dvou experimentli. Prvni experiment mél za cil ovéfit navrZzenou
metodiku a za pomoci stimull z databaze IAPS ovétit validitu dat vychazejicich
z ptistroje Emotiv EPOC+. Druhy experiment mél za cil zjistit pisobeni lidskych emoci
pfi préci s kartografickym produktem ¢i pfi feSeni prostorovych uloh.

Navrzend metodika zpracovani EEG signalu za ucelem ziskdni emoci se sklada ze
Ctyf ¢asti. Prvni ¢asti je samotné méteni dat. Druhd ¢ast se zabyva predzpracovanim dat.
Tato ¢ast vyhradné probihala ve specializovaném toolboxu EEGLAB, ktery, jak jiz nazev
napovidd, slouzi pro analyzu a vizualizaci EEG dat. Pfedzpracovani dat sestava
z postupnych krokii, jako je odstranéni artefaktl, analyza nezavislych komponent,
odstranéni kolisani nulové izolinie signalu a filtrace dat do vlnovych pasem. Treti ¢asti
navrzené metodiky je extrakce charakteristickych rysu signalt. Jejim smyslem je ziskani
hodnoty, ktera je charakteristickd pro dany signal. Tim se v praci stala primérna hodnota
vykonového spektra signdlu, jeZz byla ziskdna za pomoci Fourierovy transformace.
Posledni ¢asti metodiky pak byla klasifikace dat, s ¢imz je spojeno 1 trénovani dat. Pro
klasifikaci dat byly vybrany klasifikatory typu SVM (Support Vector Machine), které se
mj. nachazeji v aplikaci softwaru Matlab, ktera nese nazev Classification Learner a ktera
byla pro klasifikaci dat pouZita.

Po sestaveni metodiky probéhl kombinovany eye-tracking a EEG experiment, jehoz
se zucastnilo 15 osob. Experiment se skladal ze dvou casti. Pfi prvni €asti byly
ucastniklim promitany vizualni stimuly z databaze IAPS a stimuly, které obsahovaly
mapy, pfiCemz bylo ucastnikim snimano EEG. Data z EEG poté byla zpracovana
navrzenou metodikou. Vysledkem této ¢asti experimentu se stal klasifika¢ni model, ktery
ma presnost pouhych 19,7 %. Pti druhé ¢asti experimentu ucastnici sebehodnotili pomoci
dotazniku SAM (The Self-Assessment Manikin), jak na né stimuly piisobily. Pfesnost
odpovédi tohoto dotaniku dosihla hodnoty 85,78 %. Z téchto hodnot je patrné, Ze
vhodnéjsim zptisobem pro hodnoceni emoci se jevi dotaznik SAM.

Druhy experiment, pii kterém mélo byt méfeno EEG tcastniki pfi feSeni
prostorovych uloh se neuskutecnilo z divodu nizké uspésnosti klasifikaéniho modelu
Z prvniho experimentu. Z prvniho experimentu totiz méla pochazet trénovaci data, kterd
by pfi druhém experimentu nebyla ziskana. Kvili nizké uspé$nosti klasifikace provedeni
druhého experimentu pozbylo smysl.
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Vysledky této prace poslouzi zejména potiebam katedry geoinformatiky, nebot” prace
ustanovuje metodiku, jak méfit a zpracovat namétena EEG data. Takova metodika do této
doby na katedife nebyla. V budoucnu je mozné na praci navazat a testovat odliSné
piistupy v extrakci charakteristickych rysti a zejména v moznostech klasifikace. Kromé
studia emoci je také mozné se zam¢fit na studium kognitivni zatéze.
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A KATEDRA GEOINFORMATIKY

Univerzita Palackého v Olomouci

Pfiloha 1

Informovany souhlas pro méreni EEG
(Tento formuléai musi byt vyplnén pred kazdym EEG méfenim)

Nazev studie: Analyza emoci pri ¢teni map a reSeni prostorovych tloh

Potvrzuji, ze mi studie byla vysvétlena a bylo mi umoznéno se na cokoliv zeptat.

Potvrzuji, ze mi studie byla vysvétlena a rozumim své ucasti v této studii.

Rozumim tomu, ze mé Ucast je dobrovolnd a mdm moznost kdykoliv studii opustit
bez udani divodu.

Rozumim tomu, ze studie neni diagnosticka a nedetekuje zadnou mozkovou
abnormalitu, i kdyz tato abnormalita mtize existovat.

Rozumim tomu, ze namétfend data mohou byt zptistupnéna i tieti strané za Gcelem
vyzkumu, pfi¢emz s veskerymi daty bude zachdzeno diskrétn¢ v souladu s

ptistupem k ochrané osobnich tudaja.

Zaskrtnutim vSech okének souhlasim se svoji ucasti na studii.

Podpis testované osoby

Jméno a Pfijmeni: Datum:

Podpis vykonavatele studie

Jméno a Ptijmeni: Datum:

Katedra geoinformatiky | Pfirodovédecka fakulta | Univerzita Palackého v Olomouci
www.geoinformatics.upol.cz




Pfiloha 2

Pramérna hodnota

Primérna hodnota

. . dimenze Valence dimenze Arousal Klasifikacni
Nazev stimulu " . o . .
(smérodatna (smérodatna kategorie
odchylka) odchylka)

Neutral Girl 4,49 (1,03) 2,63 (1,70) LV-LA
Rocks 4,45 (1,13) 2,51 (1,72) LV-LA
Stool 4,63 (1,17) 2,71 (2,20) LV-LA
Shoes 4,52 (1,11) 2,03 (1,51) LV-LA

Trash Can 4,43 (1,16) 2,55 (1,77) LV-LA
Hammer 4,55 (0,93) 2,27 (1,70) LV-LA
File Cabinets 4,45 (1,36) 2,81 (1,94) LV - LA
Ironing Board 4,23 (1,58) 2,96 (1,90) LV-LA
Office 4,25 (1,45) 2,95 (2,17) LV-LA
Empty Pool 4,03 (1,38) 2,63 (1,75) LV-LA
Grieving Female 2,44 (1,64) 5,00 (2,03) LV - MA
Hospital 1,95 (1,58) 4,53 (2,23) LV - MA
Girl 2,67 (1,66) 4,63 (1,93) LV — MA

Bum 2,56 (1,32) 4,31 (1,81) LV — MA
Distressed Female 2,58 (1,56) 4,95 (2,27) LV — MA
Cemetery 2,06 (1,54) 4,00 (2,09) LV — MA
Mastectomy 2,56 (1,66) 4,92 (2,28) LV - MA
Cigarettes 2,54 (1,75) 4,86 (2,63) LV — MA
Woman 2,20 (1,31) 4,88 (2,21) LV - MA
Crying Boy 2,56 (1,41) 4,61 (2,07) LV — MA
Explosion 1,62 (1,20) 7,15 (2,24) LV —HA
Skinhead 2,04 (1,57) 6,05 (2,71) LV - HA
Hanging 1,76 (1,08) 6,81 (2,09) LV —HA
Soldier 1,51 (1,15) 7,07 (2,06) LV - HA
Sliced Hand 1,83 (1,17) 6,08 (2,40) LV —HA
Hurt Dog 1,69 (1,10) 6,58 (2,12) LV - HA
Starving Child 1,66 (1,10) 6,04 (2,40) LV - HA
Burn Victim 1,31 (0,97) 6,91 (2,57) LV —HA
Mutilation 1,45 (0,97) 6,41 (2,62) LV - HA
Baby Tumor 1,46 (1,01) 7,21 (1,99) LV —HA

LV =nizka valence (low valence), LA = nizkd arousal (low arousal), MA = stfedni
arousal (middle arousal), HA = vysoka arousal (high arousal)




Pfiloha 2

Primérna hodnota

Primérna hodnota

. . dimenze Valence dimenze Arousal Klasifikacni
Nazev stimulu " . o . :
(smérodatna (smérodatna kategorie
odchylka) odchylka)

Girl 6,17 (1,51) 2,90 (1,89) HV - LA
Gannet 6,37 (1,62) 2,83 (1,87) HV - LA
Flower 7,08 (1,77) 2,67 (1,99) HV - LA
Flower 7,14 (1,50) 3,00 (2,25) HV - LA
Flower 6,51 (1,73) 2,74 (2,13) HV - LA

Farmland 6,31 (1,60) 2,79 (2,20) HV - LA
Three Men 7,14 (1,46) 2,90 (2,14) HV - LA
Grain 6,23 (1,60) 2,84 (2,04) HV - LA
Leaves 6,36 (1,70) 2,51 (2,01) HV - LA
Violin 6,50 (1,72) 2,60 (2,08) HV - LA

Seal 8,19 (1,53) 4,61 (2,54) HV - MA
Bunnies 8,28 (1,07) 4,10 (2,31) HV - MA

Porpoise 7,90 (1,48) 4,27 (2,53) HV - MA

Baby 8,20 (1,31) 4,57 (2,53) HV - MA
Seaside 8,03 (1,09) 4,60 (2,48) HV — MA
Kitten 8,21 (1,21) 4,31 (2,63) HV - MA
Family 8,03 (1,26) 4,90 (2,20) HV - MA
Sunset 8,00 (1,48) 4,92 (2,65) HV - MA

Sky 7,61 (1,48) 4,51 (2,85) HV - MA
Couple 7,77 (1,43) 4,68 (2,43) HV - MA
Money 7,91 (1,66) 6,44 (2,29) HV - HA

Rollercoaster 7,63 (1,41) 6,07 (2,31) HV —HA
Gymnast 7,74 (1,53) 6,14 (2,19) HV - HA
Rafting 7,77 (1,29) 6,73 (2,24) HV - HA
Skier 8,10 (1,39) 6,28 (2,57) HV - HA
Skydivers 7,57 (1,52) 7,27 (2,08) HV - HA
Sailing 7,73 (1,34) 6,65 (2,20) HV - HA
Cupcakes 7,38 (1,73) 6,28 (2,16) HV - HA
Astronaut 7,33 (1,51) 5,87 (2,50) HV —HA
Erotic Female 8,02 (1,93) 7,17 (2,69) HV - HA

HV = vysoka valence (high valence), LA = nizka arousal (low arousal), MA = stfedni
arousal (middle arousal), HA = vysoka arousal (high arousal)
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Pfiloha 3
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